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About form•Z Demo
WELCOME to form•Z RenderZone Demo , the demonstration version of
the 3D form synthesizer with photorealistic rendering.  This is a partial
version of form•Z  that will allow you to experience the interface and most
of the modeling and rendering capabilities of the program.  It does not
contain the drafting and it does not allow you to save or print.  For a more
complete evaluation of the program you may want to order the form•Z
RenderZone Evaluation package, which is an essentially complete ver-
sion and comes with a complete set of User's Manuals.

Note that, while there are two versions of our software there is only one
demo version, form•Z RenderZone Demo .  Any mentions of form•Z
Demo  refer to the same demo version.  The features of form•Z RenderZone
Demo  are summarized in two documents.  This form•Z Mini Manual
discusses the interface and modeling features.  The advanced rendering
features are discussed in the companion document form•Z RenderZone
Mini Manual .

How to use this manual
You should use this Mini User's Manual in conjunction with the form•Z
Quick Reference Guide  which contains a comprehensive list of all the
tools, menu items, and dialogs of the system.

This mini manual is intended to give you a "quick" overview of the modeling
features of form•Z .  Admittedly, this is done at the risk of under-represent-
ing the power of the program.  All the examples are at the simplest possible
level.  Our hope is that most of the users of form•Z RenderZone Demo  will
venture on to levels of modeling sophistication beyond those covered in this
manual.  We hope that you will enjoy "discovering" the power of form•Z .

The presentation of the material is done in the order in which the iconic tools
appear in the tool palette, from top to bottom.  There are a few exceptions.
The insertions, even though they are controlled by tools on the first row, are
discussed at the very end.  This is simply because using them requires an
understanding of features discussed later.  The reference planes are
discussed at the beginning.  Also, the Move tool is needed and used a few
times before it is discussed in detail. The menu commands are discussed
in no particular order, whenever their functionality is needed for the
execution of an example.

This manual is written mostly as a tutorial.  When you move from one
example to the next, you should either Undo or Clear (both in the Edit
menu) what you were doing earlier, even when such an instruction is not
given explicitly.

Getting help
As you run form•Z RenderZone Demo , quick summary information about
specific tools and commands can also be obtained through the Help menu, which
contains items leading to information about the different areas of the program.
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Communicating with form•Z

form•Z  is organized by projects.  Each project has its own windows. There
are two types of windows: modeling  and drafting  windows.  (The drafting
module is not included in the demo version of the program).  When you
launch form•Z RenderZone Demo  by double clicking on its application
icon, it opens a new project and a new window, as shown below.  You can
also launch the program by double clicking on the icon of a previously saved
project.  While you cannot save in the demo version, a few sample projects
are provided with your demo disk and you can also start the program  by
double clicking on them.

You communicate with form•Z  through the menu bar  commands  or items
at the top of the screen, the tool palette   (or iconic menu )  on the left,
floating  palettes   dedicated to particular operations, and the  window tool
palette   found on the lower margin of each window. If you are running a
Macintosh, the red number in the same margin is the memory box  which
shows you the computer memory currently available to your form•Z work
session.  Windows systems use virtual memory and no memory box is
displayed for them.

A variety of dialog  boxes   are also used to set parametric options.  The
dialog that affects a tool can be invoked from the tool by double clicking on
its icon or by clicking on its icon while pressing option  (Mac) or ctrl +shft
(Windows).

The screen also contains a graphics window   which occupies most of the
screen.  Shown in the window are three orthogonal or Cartesian  axes  and
a grid . The grid represents the active reference plane , where objects can
be drawn.
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You execute a menu bar command in the standard manner:  position the
cursor of the mouse on the title of the menu, press the button, drag the
cursor to the desired item, and release the button.  Some of the menu items
pop out sub-menus (or hierarchical menus).  You select an item from a sub-
menu by dragging the mouse to the desired item, and then releasing the
mouse button. The menu items that end with three dots (...) invoke dialogs.
All the other items execute an operation. The menu items that have an
asterisk (*) after their name execute an operation which is affected by
options selected from a dialog.  To invoke that dialog, select the item while
pressing the option  key under Mac OS or the ctrl+shft  keys on Windows.

Iconic tools are selected in a similar fashion. Pressing the mouse on an icon
of the tool palette pops out more icons, any of which can be selected by
dragging the mouse to it.  Dragging the mouse beyond the last icon tears
the icons off as an independent palette which can be positioned anywhere
on your screen.  You can also turn icons off and shorten your tool palette.
This is done in the Help environment.   Within the modeling help window,
you can turn a tool off or on by double clicking on its icon.

The  tool palette contains fourteen rows of tools which are color-coded.  All
the icons shown in black are operators .  When they are executed, they
typically cause a visible affect on what is currently shown on the screen.
Except for the icons on the fourteenth (last) row, all black coded icons
operate on objects.  The icons on the last row operate on the reference
planes.  The operators are mutually exclusive.  When a new one is selected,
the previously active operator is deselected.

The teal and magenta colored icons are modifiers .  They are used to set
the system to a certain state or mode which affects the behavior of the
operators.  The modifiers are mutually exclusive within their own rows.
There are three rows with modifiers.  The icons on the first row tell the
program what type of an object to generate (or what type of an insertion
operation to execute).   They work in conjunction with the drawing tools on
the second and third rows.  They essentially tell the system what to do with
the shapes drawn by the user.

On the 4th row are the topological level  modifiers: point , segment ,
outline , face , object , group , and the special level hole or volume .
form•Z  has the ability to apply most of its operations  to any of these levels.
On the 10th row are the self/copy  modifiers.  When executing a geometric
transformation (move, rotate, scale, or mirror) they tell the system whether
to execute it on the object itself, on a single copy, or whether to produce
multiple copies.

All objects can be generated graphically or through numeric input, which is
handled by the Prompts   palette.  Graphic and numeric input can also be
mixed.  As you draw an object,  you can place the mouse cursor in the
Prompts palette and type a number, instead of clicking it in the graphics
window.  The Prompts palette also informs you about the steps required by
an operation and what input is expected next.

5
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About form•Z and its types of objects

form•Z   is a general purpose solid and surface  modeler , which offers the
tools to generate, manipulate, and sculpt objects directly in 3D space.

The basic types of modeling objects are surfaces and solids .  A surface
object can be a simple open or closed line or a meshed surface.  An object
is solid when it is completely enclosed, which makes it well-formed .
Variations of these basic types are the surface solids ,  which are two-sided
surfaces that are completely enclosed but contain no volume, and  the
enclosures , which can be surface or solid objects, and which are double
line ("wall") objects that contain space.  The controlled curves  and the
controlled meshes  are curved objects which internally carry the control
parameters that generated them, and therefore their forms can be easily
changed after their initial creation.

open surface objects closed surface objects

surface solids 3D enclosures
solid objects

double sided surface mesh
(surface solid)

solid meshone sided surface mesh
(surface object)
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The models on the previous page that illustrate the different types of objects
available in form•Z  also show the variety of 2D shapes and 3D forms that can
be generated directly with the tools of the program.  These basic forms can
be composed into more complex forms using operations such as the
Booleans.  In addition, tools are available for the direct creation of complex
forms, such as those illustrated below.

Three types of terrain models  trimmed to a site's boundary can be generated
from contour lines.  Both 2D and 3D text can be generated from outline fonts
(TrueType and PostScript), and can be placed in straight lines or along freely
unfolding control lines.  Solid, surface, and wire helixes and coils , as well as
spiral stairs , screws , and bolts , can be generated directly as special types
of objects of revolution.  A variety of spherical objects, including the Platonic
solids , the soccer ball , lathed and geodesic spheres , can be created
directly with a few clicks.  The metaformz  are special parametric objects that
blend smoothly when they overlap.  The generation of these objects is
discussed in more detail in this Mini User's Manual.

screws and boltsspiral stair

terrain model

Platonic solids, soccer ball, and spheres

helix and coil

3D text

metaformz



form•Z Demo Mini User's Manualform•Z Demo  Mini User's Manual

Reference planes, grids, and their palette

The three orthogonal  axes   and the grid   are shown in the graphics window
in the current view.  From the View menu select the Top item and observe
the result.  Try some of the other View items to see how your view changes.
When in one of the 3D views, select Perspective and see how the image
of your grid changes.  In form•Z  you can work in one of four available 3D
view types:  axonometric , isometric , oblique , and perspective.  Pan-
oramic is also available as a special 3D view.  You may try them all,
however, axonometric views are used almost exclusively in this manual.
Select Axonometric to go back to an axonometric view.

The grid represents the active reference plane , where objects can be drawn.
To get a sense of scale, the default grid is 64 feet by 64 feet (20x20 meters
in metric).  It is colored using two shades of teal.  Each of the small squares
is 2 feet by 2 feet and the larger squares are 8 feet by 8 feet.  (In metric, they
are 50x50 cm and 1x1 m.) You can adjust these intervals through the
Window Setup dialog, which you can invoke from the Windows menu.
You can also change the scale of your image using items in the Display
menu.  Observe how the ends of the axes are marked with plus (+) and minus
(-) signs to indicate their directions.  The reference plane can be any of the
Cartesian planes (XY, YZ, or ZX) or a plane generated by a user anywhere
in 3D space.  Reference planes may be switched through the first (left most)
icon of the window palette  ( ,  ,  ,  ).

User defined reference planes are created using the Define Arbitrary Plane

tool ( ), the first tool on the last row of the tool palette, and three points,

two segments, or a face of an object you have created.  To use three points

set the topological level to Point ( ), select the Define Arbitrary Plane tool,
and click on any three points.  To use two segments or a face, you execute
the operation in an analogous manner.  (Since you may not have created
any objects yet, try this as soon as you do).

The last row in the tool palette also contains tools which allow you to create

a perpendicular plane ( ), to move ( ) or rotate ( ) a plane, to move

its origin ( ), to extend its boundaries ( ), and to reset ( ) it.

When you select  from the window palette you
invoke the most recently defined arbitrary plane.  You
can also store reference planes in the Planes  palette
(which you can invoke from the Palettes menu),
and assign names to them.  Click in the Plane Name
column of the palette, type the name you desire, and
then click in the column (away from the name) again.
After a plane has been named and entered in the
palette, you can  invoke it by simply clicking in front of
its name.

8

Mouse movement and the perpendicular lock

When you use the mouse to draw, its positions are mapped onto the active
reference plane (or to positions parallel to the reference plane).  You can
read the values of these positions in the Coordinates and the Prompt
palettes.  If you select the Perpendicular switch  ( , second icon in the
window palette), the mouse will move in a direction perpendicular to the
current reference plane.

Snapping

By selecting the Grid Snap icon ( , 3rd in the window palette), you can
lock the motions of the mouse to the nearest grid line.  By default, the
snapping parameter is 2'.  It can be changed in the Grid Snap Options
dialog, which you can invoke by double clicking on the Grid icon.

Directional snaps, which lock the motions of the mouse to the horizontal,
vertical, diagonal, or other directions, are available in the 4th position of  the
window palette ( , , , ).  The 5th position contains a variety of
object snaps, which allow you to lock the mouse to the nearest point,
segment, mid-point, etc. ( , , , , , , , , , ).

Zooming and panning

Using one of the tools in the 6th position of the window palette, you can
zoom in and out, pan, fit your image to the screen, etc.  There are five zoom
tools.  The magnifying glass ( ) tool zooms in and out relative to the point
where you click.  You can also zoom in and out by drawing a rectangular
frame to delineate the area that will be zoomed ( , ), or by applying an
incremental factor ( , ).  By default, you draw the zoom frame from
center to perimeter.  Place the cursor at the center of the area you wish to
delineate, and drag the mouse outwards.  This rubber bands a rectangle
until you release the mouse.  You can also select the option that will allow
you to draw the zoom rectangle from corner point to corner point.

When you execute a Zoom by Frame operation and the Continuous
Window Tool Control option is selected in the Preferences dialog
(Edit menu), the modeling tool palette is grayed out indicating that the
window icons have control.  This allows you to execute any number of
zooms sequentially.  To exit the zoom mode, click the mouse on any of the
modeling or window tools.  When you execute an incremental zoom, by
default the system applies a 75% and a 133% scaling factor for zooming out
and in, respectively.  You can define your own scaling factors by invoking
the Zoom Options dialog.

There are two tools for panning: the Hand ( ) and the Pan ( ) tools.  Also
available are window tools for returning to the previous zoom/pan setting
( ), returning  to the  initial setting ( ), or automatically scaling the view
in a manner that fills the screen ( ).

9
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• Click the mouse on the reference grid and release it.  As the cursor is
moved a rectangular shape is rubber banded and follows the motion of the
mouse.  Click again.  An extruded rectangle is generated.

To generate a hexagonal extrusion:
• While the selection on the first row remains as before, select the Polygon

tool ( ) from the 2nd row of the tool palette.
• Click the mouse where you want the center of your hexagon to be, then

move it and click again to determine the size of hexagon.
Note that in form•Z  you do not drag the mouse when you draw a shape.  You release it and click
again for the next point.  This offers two advantages over the "drag" method: it gives you the
opportunity to execute other operations, such as zooming, while you are drawing, and it allows
you to rest your arm between input points, whenever precision is required.

The two objects you just generated have the same height, which is  10' - 0".
A different height can be used by selecting another number from the
Heights menu.  The height value can be positive or negative.  You can use
the Custom... item in the Heights menu to enter heights that are not
included in the preset list.  The custom heights are typed in the Custom
Height dialog which appears when Custom... is selected.  To add a
height to the Heights menu, click on the Add To Menu button of the
dialog.  Custom heights can be selected as any other height item.

Height values already in the Heights menu can be removed or changed
using Edit Menu..., at the bottom of the Heights menu.  When selected,
the Heights Menu dialog appears.  Selecting a value in its heights list
places it in the numeric field where it can be changed.  Clicking on the Add
button adds the new value to the heights list.  Clicking on Remove
removes the height from the list.  The content of the Heights menu can be
saved by clicking on Save...  and previously saved heights files can be
retrieved by clicking on Load....  form•Z  is currently shipped with three
height files, preset at three different levels of magnitude.

You can also select the Graphic/Keyed item (1st item in the Heights
menu) to enter the heights of your objects interactively (graphically or
numerically).    When you do, as soon as you draw the base of your object,
a 3D object is rubber banded and its top face follows the motion of the
mouse, which is locked to a direction perpendicular to the reference plane
or to a surface of an object, depending on the option selected in the
Extrusion/Convergence Direction dialog.  When you click again,
the height of your object is determined.  To enter a height numerically, you
type it in the Prompts palette next to the "Height :" prompt, and press return.
The following examples illustrate the different methods for entering heights.

Generating objects
To generate a rectangular object:
• From the first row of the tool palette,

select the 3D Extrusion modifier ( ).

• From the 2nd row select Rectangle ( ).
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•Clear (Edit) and turn on Grid Snap ( ).
• From the Heights menu select -2'-0".

• Select the  3D Extrusion ( ) modifier and

the Rectangle ( ) tool.
• Click on 1 and 2 to draw a rectangle the size

of the grid.  A 3D object is extruded on the
negative side of the reference plane.

• From the Heights menu select Custom....
• In the Custom Height dialog that is in-

voked, type 24', and click on Add to Menu.
The 24' height is added to the Heights menu
and becomes the active height.
• With 3D Extrusion and Rectangle still se-

lected, click on 3 and 4.
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• From Heights, select Graphic/Keyed.

• Select the 3D Enclosure ( ) and Vector Line ( ) tools.

• Click on 5, 6, 7, and double click on 8.  A 3D enclosure (wall object) is
rubber banded and moves perpendicular to the grid.
• Watch the height value in the Prompts palette and click when it is 6'-0".

• Select the 3D Converged Solid ( ) and Rectangle ( ) tools.
• Click on 9 and 10.  When the pyramid is as high as ours, click again.
• Click on 11 and 12, then click again when the height of the second

pyramid is roughly as ours.

You will next create objects by drawing on
other existing objects.

•Double click on the 3D Convergence ( )
tool to invoke the Extrusion/Convergence
Direction dialog.  Select the Perpendicu-
lar To Surface option.
•Select the Snap to Face ( ) window tool.

•With 3D Convergence ( ) and Rectangle

( ) selected, draw  a rectangle on the front
face of the tall cuboid (click on 13 and 14).  A
pyramid is rubber banded in a direction perpen-
dicular to the surface on which you drew.
•Click again to complete the object.

Create a hexagonal 3D Enclosure on the side
of the previous pyramid, as shown.

Note that the images on your screen look different from the ones we show on this page.  Our
images are plotted in what is known as the hidden line mode, which does not display the lines
that are behind other objects.  The display types available in form•Z  are discussed on page 14.
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Undoing, redoing, and deleting
If you make a mistake or, for some reason, you do not want one or more of
the objects you created, you can select  the  Undo command from the  Edit
menu, which will cause them to disappear.  If after you undo you change
your mind, you can select the Redo item (also in the Edit menu) to bring
the most recent object back.
form•Z  offers you unlimited undos, the ability to execute any number of sequential undos in one
step, and the ability to  determine the depth of the undo records, that is, how many undo steps
are saved.  You can also optionally save the undo records when you save your projects (but
saving is not available in this Demo version of form•Z ).  In this Mini Manual the undos will be used
with their default settings.  That is, one operation will be undone each time you select Undo.
When we need to undo more than one operation, we explicitly instruct you to execute the Undo
two or more times.

When drawing lines, arcs, or curves (see page 16) you can also select the
Undo item to cancel the most recently entered point.  Or you may undo
individual points by using its key-equivalent command:  command+Z  on
the Macintosh or ctrl+Z  on Windows.

You can also delete an object  by selecting  the Delete tool ( ) and  clicking

on it (with the topological level set to Object).  You can achieve the same
result by selecting (picking, see page 17)  the object and then pressing the
delete key on the Macintosh or the backspace  key on Windows.  Note that
while the Undo and Delete commands may appear to produce the same
result, they are distinctly different operations.  In addition to deleting
complete objects, you can also delete entities at other topological levels,
such as points, segments, and faces.

Viewing
As already discussed in the Reference Planes section, modeling scenes
can be displayed in 3D views, or as orthographic projections (front, back,
top, bottom, right, or left elevation).  These items and preset 3D views are
selected from the Views menu, which also contains the Custom View
Angles... item.  It invokes a dialog where any view angles can be entered.

There are also interactive graphic methods for determining the position of
the viewer.  The Edit Cone Of Vision item (bottom of Views menu)
invokes the Cone of Vision environment where the position of the viewer
and a variety of other viewing parameters are manipulated with the mouse.

From the window palette, the Rotate View  ( )  and Set View ( ) tools
can be used to graphically manipulate the view.  The Match View ( ) tool
can be used to match the view to that of a background image (underlay).

To use the Rotate View tool, you first click on the reference plane axis
around which you wish to rotate the view.  The next mouse click rubber
bands your view and the third click generates it.  When using the Set View
tool, your first click rubber bands your view.  The motion of the mouse
represents the motion of the viewer who can move to the right, left, up, or
down, and your view is adjusted accordingly.

12 13

Viewing QuickTime VR ™ movies
In form•Z  you can create, save, export and even view two types of QTVR
movies: panoramic and object movies.  While saving is disabled in the
Demo version of form•Z , you can view a few sample movies that were
produced with form•Z  and are shipped with the Demo version.  We do one
example below.

•From the File menu click on View File....  This invokes the standard
File Open dialog.  Search for a folder labeled "VR Samples" and open it.
Then double click on the movie file labeled "Ronchamp.mov."

This opens a QTVR window, on
top of your current windows.  It
displays a view of the interior of
the Ronchamp Chapel, as shown.
You can click and drag on the
image to browse around the inte-
rior of the chapel.  You can also
use the Zoom in and out tools
(lower left margin of the QTVR
window) to move closer or farther.

The movie you are playing is of the panoramic  type.  That is, behind the
QTVR window is a panoramic image, such as the one shown below.  This
is derived by placing the viewer (camera) in the middle of a scene (or
interior space), rotating it at even increments, and rendering pieces of the
environment, which are then pasted together into a single image.  The
other type of movie that is available, the object movie, is essentially the
reverse.  A camera moves around a scene taking shots towards the center
of the scene.

For both types of movies any of the display modes available in form•Z
(ranging from wire frames to ray tracings) can be used.  These are
discussed in the next section.  Note that panoramic images can also be
produced and saved by themselves, regardless of whether they are used
for a movie or not.  However, this is not possible for object movies, which
can only be saved as movies.
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Plotting and rendering
The objects you have created have been sofar displayed with all their lines
visible (wire frame). You will now try the other plotting and rendering
methods available in form•Z .  The objects you created in the most recent
example should still be on your screen.  Undo twice to simplify the scene,.
To see your objects better, you will also turn off the grid and the axes.

• Select Window Setup... (Windows menu).
• In the Window Setup dialog deselect Show
World Axis, Show Reference Plane Axis,
and Show Grid.  Your image should be as
shown with all its lines visible.
Note that all the display commands in the Display menu have
asterisks at the ends of their names indicating that there is a
dialog that affects their execution. This dialog can be invoked
by clicking on them while pressing the option key on the
Macintosh or ctrl+shft  on Windows.

• Invoke the Wire Frame Options dialog.  In
it  select Show Points.  Your image should
appear as shown, with the points (vertices) of the
displayed objects marked with a diamond.

• From the Display menu, select Quick Paint*.
Your image is now rendered in color.  All the
objects have the same color, which was auto-
matically assigned to them when they were cre-
ated.  The color can be changed using the Color
tool (on the 12th row).

• From the Display menu, select Hidden
Line*.  Your image is now plotted with lines, as
for the wire frame.  However, only the lines that
are not covered by other surfaces are plotted.

The Hidden Line Options dialog also contains
the Hide Edges With Angle Greater Than
option.  When on and Hidden Line* (Display
menu) is executed, edges with angles greater
than the value entered in the dialog's numeric
field (which can be any value between 0° and
180°) will not be shown.  This is illustrated by the
images on the left.  For the top image the Hide
Edges With Angle Greater Thanoption was
deselected.  For the lower, the option was se-
lected and 140° (default) was entered in its field.
Note that we are not suggesting that you generate these objects
since they involve material we have not  yet covered.  However,
you will know how to create them after just a few more pages.
When you do, you may generate a hidden line plot to verify how
the Hide Edges option works.
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You will next do a surface rendering with
shadows.

•Select Sun Position... (View menu).
• In the Sun dialog enter 30° in the Sun
Altitude and -15° in the Sun Azimuth
fields.
• In the Display menu, select Surface
Render* while pressing the option  key on
the Macintosh or the ctrl+shft  keys on Win-
dows.
• In the Surface Rendering Options

dialog that is invoked, select Render With
Shadows and click on OK.
• Invoke the Surface Rendering Op-
tions dialog again and deselect the Show
Color option.  Both renderings should be
the color versions of the ones we show.

You will next use Shaded Render* to render  some of your objects
shaded and some as wire frames.

•Double click on the Set Rendering Attributes ( ) tool (12th row) to
invoke the Object Rendering Options dialog.  In it select Object
Renders As Wireframe.
•With the Set Rendering Attributes tool click on the enclosure object.
• Invoke the Object Rendering Options dialog again and deselect
Object Renders As Shaded Surface.
•With the Set Rendering Attributes tool click on the larger pyramid.

You may also want to change the color of the base slab to brown and of the
pyramids to green.

•Double click on "Light 1" in the Lights
palette and when the Lights Parameters
dialog is invoked turn on Shadows.
•Select Shaded Render* while pressing

option  or ctrl+shft .  In its dialog select
Render With Shadows, Render Using
Antialiasing, and click on OK.  Observe
the result.

The Display menu also contains the RenderZone* and QuickDraw
3D* items.  The former produces the most precise renderings and is
discussed in the form•Z RenderZone  Mini Manual.  QuickDraw 3D*
produces shaded images that can be manipulated dynamically.  However,
for QD3D to work well, high end PPCs and accelerators are recommended.

Return to Wire Frame* display, and reactivate the Show World Axis
and Show Grid options  before continuing with this tutorial.
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2

Object types

To review and sample all the types of objects that can be generated in a
direct manner,  select all the teal modifiers on the first row, one at a time,
and for each draw a rectangle, any polygonal shape, or a circle.  You can
select polygons other than hexagons by invoking the Polygon Options
dialog directly from the tool. You can also select more than the default 24
segments for the circles by invoking the Arc/Circle/Ellipse Resolu-
tion dialog. You will generate:

Drawing objects

The tools on the 3rd row can be used to draw open lines
or closed shapes for the generation of free form ob-
jects.  These tools can be combined by switching from
one to another during the drawing process.  This allows
you to mix straight lines with arcs and curves.  You can
draw the shape shown to the right, as follows:
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2D enclosure   ( )

converged  (extrusion to point)  ( )

3D enclosure  ( )

( )  2D surface object

 ( )  extruded object
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• Select Top from the View menu.
• Select the 2D Surface Object modifier (1st on 1st  row).

• Select the Draw Vector Line icon and click the mouse on point 1,
then on 2 and 3.

• While at 3, switch icons and select the Arc, Clockwise, Endpoint-Last
tool.  Do not worry about the rubber-band following the mouse
as you go to select the new icon.  It will fall in place as soon as you
return to the graphics window.  Click the mouse on point 4 (the
center of the first arc) and then on 5.

• While at 5, select the Arc, Counterclockwise, Endpoint-Last icon, then
click on point 6 (the center of the second arc), and then on 7.

• While at 7, select the Draw Vector Line operator again and triple
click on point 8.  The shape is closed and the drawing process is
completed.

A double click  of the mouse generates an open line.  A triple click   creates
a closed shape.  You can also close a shape by returning to the first point
and double clicking.  Try the other drawing tools on the 3rd row.  If you make
a mistake as you draw, you can cancel individual points by selecting Undo
(or by pressing command+Z  on the Macintosh or ctrl+Z  on Windows ).
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Picking

Objects or parts of objects can be picked using the Pick tool (selection

arrow, ), on the 5th row of the tool box.  Selected entities are highlighted

with  red.  The highlight color can be changed in the System Colors
dialog, which you can invoke from the Options menu.  Whether a complete
object or a part of an object (point, segment, outline,  face, or hole) is picked
is determined by the selection of the topological level from the 4th row of

the tool box.  Points ( ), segments ( ), objects ( ), and groups ( )

are picked with a single mouse click. Outlines ( ), faces ( ), and holes/

volumes ( ) may be picked with one or two mouse clicks, depending on
which option is selected in the Pick Options dialog.  With the Clicking
Inside Boundaries option you click the mouse once inside the boundary
of a face, outline, or hole.  With the Clicking On Edges option you need
to click the mouse on two segments of the face, outline, or hole.  While the
single point pick is frequently more convenient to use, it is less general than
the two point pick.  You can only use it to pick front facing entities.  The two
point pick allows you to pick faces, outlines, and holes anywhere.

Note that by default, you do not need to hold the shift  key down in order to
select more entities.  You can select any number of entities by clicking
directly on them.  You deselect a selected entity by picking it again.  You
deselect all the selected entities (clear your picks) by clicking away from a
selectable entity.  However, if you prefer to press the shift  key in order to
select additional entities, you can turn on the Use Shift Key For
Multiple Pick option in the Pick Options dialog.

A number of entities at the same topological level (such as all points) can also be
picked by delineating an area that contains them.  Select the appropriate
topological level, click the mouse away from a selectable entity and drag it to
another position.  A rectangular frame will be rubber banded until you release the
button.  As soon as you do, all the entities contained in the rectangle are selected.
You can also select the Lasso option in the Pick Options dialog to delineate the
pick area by drawing a free form line.

In form•Z ,  you can execute operations using either a prepick  or a postpick
method for the selection of the operand objects.  The postpick is incorporated into
the operators: you select the operator and then the entity or the entities to which
the operation will be applied.  To use the prepick method, you activate the Pick
operator and then select any number of entities (which, for most operations, may
even be at different topological levels).  You then select the desired operator and
click the mouse once again.  For most of the operations, the last mouse click is
anywhere on the graphics screen and away from a selectable entity.  For
operations that involve two types of entities, the last click picks the second entity.
For example, the objects of revolution (lathing) are derived by rotating a source
shape around an axis.  The source shape(s) may be prepicked, but the axis must
be picked at the end, after the selection of the operator.
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Derivative objects
Using the tools on the 6th row, you can derive new objects from other
objects, such as a 3D extrusion from a surface object.

• Draw a 2D rectangle, as shown.  Then, from the 6th row of the tool

palette, select the Derivative 3D Extrusion operator ( ) and, with
topological level at Object, click the mouse on the rectangle.  A 3D
extruded object is generated from the rectangle.
•Undo and repeat the operation after selecting the 3D Conver-

gence operator ( ).
•Undo again and repeat the operation after selecting the 3D

Enclosure operator ( ).

• Generate a cube, as shown, and set topological level to Face ( ).
• From the Heights menu, select a lower height than the one

used for the cube.  Select the Derivative Extrusion operator ( ),
and click on two segments of the top face of the cube (assuming
that the Click On Edges option is currently selected in the Pick
Options dialog).  A cuboid is generated from the top face of the
original cube.  You can also generate one derivative object from
each face of the cube with a single operation.

•Undo and set the topological level back to Object.
• Invoke the Extrusion/Convergence Direction dialog

(double click on the Extrusion tool), select Perpendicular to
Surface, and close the dialog (click on OK).
• With the Derivative Extrusion tool selected, click on the cube.

A new object is generated for each face of the cube.
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Derivative objects can also be generated from parts of other objects, such as faces.

Ghosting the operands
When an object is used for an operation, such as to generate a derivative object,
the original object may be ghosted (the default), deleted, or left as it is.  These
options are selected from the Status Of Objects palette,  which is displayed on
your screen by default.  If it is not currently displayed, you can open it from the
Palettes menu.  Note that the Status Of Objects parameters may be set to
have a global effect (when the checkbox in the palette is on) or to independently
affect individual tools.  In the latter case the Status Of Objects palette is context
sensitive and always displays the setting of the active tool.

Any object may also be ghosted or unghosted by the user, using the Ghost ( )

or the Unghost ( ) tools on the 12th row of the tool palette.  Ghosted objects are
shown in light gray and remain inactive until they are unghosted.  You can also
select the Hide Ghosted item (Edit menu) to make the ghosted objects invisible.
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Objects of revolution
Objects of revolution are generated from shapes that are
rotated about an axis.  The axis can be one of the
Cartesian axes, an axis of a reference plane, or any
segment of an existing object.  Four types of objects can
be generated using the Object of Revolution tool: lathed
objects , helical objects , screws and bolts , and spiral
stairs .  You will first do a few examples of lathed objects.

•Switch the reference plane and grid to the ZX, by
selecting    from the window icons and make sure Grid
Snap ( ) is on.
•Draw an open 2D shape, as shown (top shape).  The

first and the last points of your shape should be on the Z
axis.
•Set the topological level to Object, select the Object of

Revolution tool ( ), click on the shape you drew, and
then on the Z axis.  The result should be as shown.

To generate a torus, use a closed shape, such as the
diamond shown, to repeat the operation.  The resulting
object should be as shown.

Spheres can be created as objects of revolution.

•Clear and Clear All Ghosted.
•Switch to the XY reference plane, and  Grid Snap ( )

should be on.

•With the Arc, Clockwise, Endpoint-Last tool ( ) draw
a semicircle, as shown, with its end points on the X axis.

•With the Line tool ( ) draw a line next to the arc.
•With the Object of Revolution tool selected, click on the

arc and on the X axis, to produce a sphere.
•Undo and click on the arc again, then click on the line.

A different object is created, as shown.

You can also revolve shapes around segments of objects.

•Generate a cuboid, roughly as shown.
•Activate the Snap to Face ( ) window tool and draw

a rectangle on the front face of the cuboid.
•Deactivate the Snap to Face tool.
• Invoke the Revolution Options dialog and in the
Revolution Angle field enter 270°.
•With the Object of Revolution tool selected, click on the

rectangle, then on the front vertical edge of the cuboid.
The result should be as shown.
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Solid and surface helixes are also generated by selecting a source shape
and an axis about which the shape is revolved.  For helixes, the source
shape is also moved along the axis as it is revolved.

• On the YZ plane, draw a hexagon, roughly as shown.
• Invoke the Revolution Options dialog, select Solid/Surface He-
lix, and click on OK.
• Click on the hexagon, then on the Z axis.

With helixes, both the source shape and the path it follows
can be scaled by setting the proper parameters in the
Helix Options dialog, which is invoked from the Revo-
lution Options dialog.  You will next generate a helix by
scaling the width (radius) of the path.

•Undo to return to the original hexagon.
• In the Revolution Options dialog, select He-
lix Options.... In the dialog invoked, enter 3 in the
# Of Cycles field, and next to Length, select Per
Cycle.  The value in the Length field should be the
default 20'.  Select Scale Path and enter 0.25 in
the Width field.  Click on OK.
• Click on the hexagon, then on the Z axis, and observe the result.

Note that the parameters you selected produced a helix that consists of three cycles,
and that the length of each cycle is 20'.  The radius of the path at the end of the helix
is one fourth of the radius at the beginning, due to the 25% scaling factor you entered.

You will next generate a wire helix and scale the width and length of its path.

•Undo to clear the screen.
• Invoke the Revolution Options dialog, and select Wire
Helix About Axis.  In the Helix Options dialog, select
Scale Path, Width = 0.1, and Length = 0.75.
• Close the dialog, and click on the Z axis.

Note that a wire helix is generated by a single click on the axis of revolution.  Where
you click is significant and determines the starting point of the wire helix.

•Undo, and select the XY plane from the window tools.  Draw a circle and
a rectangular open shape, as shown.
• Select Wire Helix Along Path  (Revolution Options dialog).
• Invoke the Helix Options dialog, and in the Wire Helix Radius field

enter 2'.  Make certain that the By Cycles option is selected, and in the #
Of Cycles field enter 40.  Close both dialogs.
• With the Object of Revolution tool selected, click

on the circle.
• Click on the open shape and observe the result.

Note how the radius of the path of the open wire helix has
been scaled by 25%, the parameter you entered earlier.
Also note that the length of the helix along path is not
scaled; it extends from one end of the path to the other.
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Screws and bolts are composite objects, the main part of which, the body,
is generated as a helical object of revolution.  The other parts, the neck and
the head, are optional, as is the tip, which is a tapered end of the body.

•Clear the screen.
• Invoke the Revolution Options dialog, select
Screw/Bolt, and click on OK.
•With the Object of Revolution tool active, click on

the Z axis.

Observe the result.  Where you click is significant,
as it defines the origin of the screw/bolt.  The
direction of the axis or segment clicked  determines
the direction of the screw/bolt.  You can set the
parameters for the screw/bolt in the Screw/Bolt
Options dialog, invoked from the Revolution
Options dialog.

•Undo, then draw a line from right to left as shown.
•From the Revolution Options dialog, invoke

the Screw/Bolt Options dialog.  In the Body
Length field, enter 30', and select the third head
shape and Phillips. Exit the dialog.
•With the Object of Revolution tool active, click on

the line you drew, and observe the result.

To conclude this section, you will generate two
spiral stairs.

•Undo as many times as necessary to clear the
screen.
• Invoke the Revolution Options dialog, and

select Spiral Stair.
•Click on the Z axis, and observe the result.

As with the other objects of revolution, spiral stairs
can be generated along any axis or segment, and in
any direction.  Their parameters can be set in the
Spiral Stair Options dialog, invoked from the
Revolution Options dialog.

•Undo and invoke the Spiral Stairs Options
dialog.  In the Inside Radius field, enter 4', in the
Total Height field, enter 40', and select By # Of
Steps.  Under Length Control, select By Total
Angle, and in its field enter 720°.  Exit the dialog.
•With the Object of Revolution tool active, click on

the Z  axis.  Observe the result.
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Sweeps along paths

Solid or surface objects can be generated by "sweeping" one 2D shape
(called the source shape) along another 2D shape (called the path shape).
Four variations of swept objects can be created, either directly or in a
preview mode.  You will first create a sweep directly.

• Draw shapes a and b, as shown.

• Double click on the Sweep Along Path ( ) tool
to invoke the Sweep Along Path Options dialog.
•  In the dialog deselect the Show Preview

option, and select Axial Sweep.
• With topological level at Object and the Sweep

Along Path tool selected, click on shape a (source),
and then on b (path).  Observe the result.

You have just generated what is called an axial sweep   for which either or both the
source and the path shapes can be open or closed.  You executed the operation
directly.  The Sweep Along Path tool can also be executed in a manner that allows
you to preview the result of the operation and to manipulate the placement of the
profile (source) shape relative to the path shape.

•Undo, invoke the Sweep Along Path Op-
tions dialog and in it select Show Preview.
• With the Sweep tool selected, click on source

shape a, then on path b.

The Sweep Preview dialog appears as shown.   Its
large window (left) contains a preview of the object as it will
be generated if you click on OK.  Its small window shows
an image of the source shape as it is placed on the path
shape.  The preview dialog also contains a number of
button commands, which you will use in the next example.

• Click on Flip Horiz.  Observe the changes.
• Select  Rotate.
• Click in the source shape preview window (point

1), start moving the mouse (slowly to be able to
observe the effect),  then release the mouse on
point 2.  Click on Fit to fit the source in the window.

You have rotated your source shape, which has
changed the overall shape of the sweep object. If
you are satisfied with what you have, click on OK to
exit the preview mode and generate your object in
its final form.

Note that there are a number of other buttons in the
preview dialog for manipulating the source shape, path,
and the view angle of your object.  You should experiment
with them.

a

b
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You will next generate sweeps using the scale and rotate options in the
Sweep Along Path Options dialog.  Note that these options can also
be set in the Sweep Preview dialog.

•Undo to clear the screen.  Generate a circle,
an arc, and a rectangle, roughly as shown.
• Invoke the Sweep Along Path Options

dialog, and select Scale Source by 0.25, and
Rotate Source By 360°. Click on OK.
•Click on source shape c, then path d.

•Select the Unghost tool( ), and click on c.
•Select the Sweep Along Path tool, and click

on c, then e.  Observe the result.

Sweeps can also be generated from two differ-
ent source shapes, as you will do next.

•Undo to clear the screen, and draw four
shapes, roughly as shown.  Note that f is a
hexagon, and g is a diamond (4-sided polygon).
• Invoke the Sweep Along Path Options

dialog.  Select Two Source Sweep, and
deselect Show Preview, Scale, and Ro-
tate.
•With the Sweep tool active, click on f and g,

then on path h.
•Unghost source shapes f and g, and repeat

the sweep operation with path i.

You will next generate a sweep using a single
source shape, and two paths.

•Undo to clear the screen.  Draw six shapes,
roughly as shown.
• Invoke the Sweep Along Path Options

dialog, and select Two Path Sweep.
•Click on source j, then on paths k and l.
•Click on source shape m, then on paths n

and o.  Observe the results.

Note that the path shapes should be drawn in
the same direction, or the resulting object will
have intersecting faces.

•Undo to return to the original objects.  In-
voke the Sweep Along Path Options dia-
log, and select Preserve Height of Source.
•Repeat the sweeps as above, and observe

the results.
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You will next generate another type of sweep, called a Boundary
Sweep.

• Draw shapes p, q, and r, as shown.  Notice the
directions marked on shapes p and q and draw them
in the same direction.  Shape r is a closed semicircle.
You can draw it by using the Arc, Clockwise, Endpoint-
Last tool and clicking on points 1 and 2, and then triple
clicking on 3.
• Invoke the Sweep Along Path Options dialog

and select the Boundary Sweep option.  Deselect
the Show Preview option.
• With the Sweep tool selected, click on source shape

r, then on path p.  The program beeps and an error
message is issued indicating that boundary sweeps
only accept open source shapes.
• Click on shape q, then on path p.  The result is a

solid object derived by connecting the ends of the
path.

You can also execute sweeps using the faces of
existing objects as paths.

• From the Sweep Along Path dialog, select Axial
Sweep again and the First Point alignment option.
• In the Status Of Objects palette  select Keep.

This will retain the original objects, rather than ghost-
ing them, which will allow you to execute the operation
more than once without having to unghost the objects.

• From the Pick Options dialog select  Clicking
Inside Boundaries.   This option will allow you to
select faces with a single mouse click.

• Set the topological level to Face.
• With the Sweep tool active, click on 4 and 5.
• Next, click on 4 and 6.
• Finally, click on 4 and 7.

The resulting objects should be as shown.

We shall next use some other objects to illustrate the
skinning operation.  But then we shall use the object
we generated here to illustrate the Section operation.

•Undo three times to return to the basic solid object.
• From the File menu select New [Model].  A new

modeling window, most likely labeled Untitled 2-1
[Model], covers the previous.  You will work on this
for the next exercise.
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Skinning

The skinning operation resembles the sweeps in that source profiles are swept
along paths.  However, any number of sources may be swept along any number
of paths, which allows you to more accurately outline the 3D form that you wish to
generate.  Skinning is both more flexible and more restrictive than the sweeps.
There are two types of skinning operations and each can be executed in two
different modes.  You will do an example of each.

• From the View menu select
Right Side.
• Turn on the Grid Snap ( ).
• Select the Arc, Clockwise, End-

point-Last ( ) tool and click on

points 1 and 2.  Then double-click
on 3.  An arc is drawn, as shown.
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•From the Display menu select Wire Frame* while pressing option  (Mac)
or ctrl+shft  (Windows).  This invokes the Wire Frame Options dialog.  In it
select Show Points and Show Marked Points.  As soon as you click on OK
and exit the dialog, the arc is displayed with its points shown.  The arc has no
marked points yet.  You will mark two of its points next.

•Double-click on the Topological Attributes ( ) tool to invoke its dialog, and in
it select Set/Clear Point Marker.

•With the Topological Attributes tool active click on each of the end points of the
arc.  As soon as you do, a larger diamond than that used for the regular points is
displayed on the points you just clicked on, indicating that these points are marked.
You will soon see how these marked points are used by the skinning operation.

•From the View menu select Top.

•Double-click on the Multi-Copy ( ) icon  to
invoke the Transformation Multi-Copy
dialog.  For # Of Copies enter 3.

•Select the Rotate ( ) tool and click on
points 4 (picks the arc), 5 (center of rotation),
6 (start of rotation), and 7 (rotation angle).
Three rotated copies of the original arc are
generated.  These are the four paths that will
be used for a skin operation.  Note that the
points you marked on the original have been
transferred to the copies.

•To see them better, from the View
menu select z=30˚ x=60˚.  Then, from
the same menu select Top again.
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We next need to mark four points on each of our source shapes.  We need to mark
one point for each of the paths.  This will tell the program which point of the source
will be placed on a path.
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You will next draw a diamond and a star to be used as
source shapes.

• Double-click on the Polygon ( ) icon and in its dialog
make certain that Polygon By # Of Segments is
selected and select the diamond (second icon from the left)
or enter 4 in its alpha field.
• With Polygon selected click on 8 and 9.  This draws a

diamond, our first source shape, as shown.
• Invoke the Polygon Option dialog again, enter 8 in

the # Of Segments field, select Polygon Pattern,
and select the upper left icon under this option.
• With the Polygon tool active click on 8, 10, and 11.  This

generates a star, the second source shape we shall use.

• With the Topological Attributes tool (and
Set/Clear Point Marker still selected in
its dialog) click on all four points of the
diamond and on corresponding points of the
star shape, as shown.  After the process of
marking points is completed, you are ready
to execute the skinning operation.

• Double-click on the Skin ( ) tool to invoke its
dialog.  In the dialog select the following settings:

• Skin Along Paths is on
• # Sources is set to 2 and # Of Paths is

set to 4.
• In the Placement Type box select By

Anchor Points.
• In the Point Pairing box select Insert

New Points As Needed.
• Generate a 3D view and with the Skin tool

active click on points 12 through 17.  The first two
clicks select the two sources and the subsequent
four clicks select the four paths.  The skinned
object is created after the last click, as shown.

Note that it took just one step to derive the skinned object.  It took many more steps to prepare and properly
position and mark the shapes that were used for the skinning.  This is typical for the Skin operation.  For
the example we just did, while the path shapes were in the position where the skinned object was created,
the sources were not.  The program placed the sources on the paths before executing the operation.
It used the points that were marked on both the sources and the paths when placing the sources.  This
type of execution is called placement By Anchor Points, which is the option you selected in the Skin
Options dialog.  The alternative method is placement By Current Position which requires that the
sources are placed on the paths exactly where they will be skinned.  We shall do such an example next.

8 9
10

11

-x

+x

-y

+y

+z

-x

+x

-y

+y

+z

15 16

12
14

17

13

• With the Circle by Center and Radius  ( ) tool click on 1 and 2 to draw a circle.
• Invoke the Polygon Option dialog and select the diamond (# Of Seg-
ments = 4).  Deselect Polygon Pattern.
• With the Polygon tool active click on 1 and 3.  A diamond is drawn, as shown.

Note that points 2 and 3 are at the end points of the path.

• From the View menu, select z=30˚ x=60°.  In the 3D view you can see that
both source shapes have been drawn on the XY reference plane, as expected.
The first points of your paths also lie on that plane and they coincide with four points
of the circle, which is proper.  Next you will move the second source shape (the
diamond) up to the plane where the end points of the paths are.
• Turn on the Perpendicular switch ( ), and select Snap to Point ( ).

• Make sure that Self ( ) is selected from the 10th row modifiers.

• With the Move ( ) tool active, click on 4 and 5.  This moves the diamond shape
up.  Do the points of the diamond lie exactly on the end points of the paths?  The
answer to this question is significant.  Whether they are or not will determine how
the skinning operation will be executed.  In our example they are not.  We
confirm this by zooming in at one of the points of the diamond, as shown
in the detail.  Therefore, we shall execute the operation using tolerances.
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•Undo and delete the source shapes (the diamond and the star).  Keep the four
paths so that we can use them again.  From the View menu select Top.  You are
now ready to draw two new source shapes.

• In the Skin Options dialog select the following settings:
• Skinning Along Paths is on.
• # Of Sources is set to 2 and # Of Paths is set to 4.
• Placement Type is set to By Current Position.
• Use Tolerance is on and its value is set to 2'.
• Insert New Points As Needed is turned on.

• With the Skin tool click on the two source shapes
and then on the four paths.  An object is generated
right after the sixth click.  Do a hidden line plot.
•Undo, invoke the Skin Options dialog and in

it select Close At Ends Of Open Paths.
• Repeat the operation, do a hidden line plot, and

observe how the result differs from the previous.
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The two Skin examples we did to this point were of the Skinning Along
Paths type.  We shall next execute a type called Cross Skinning.

• From the Edit menu, Clear and Clear All Ghosted to start fresh and from
the View menu select Front.
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To do one more example, Undo twice and from the View menu select Top.
• In the Polygon Options dialog, set # Of Segments to 8, select Polygon
Pattern, and select the left pattern on the second row.

• With the Polygon ( ) tool click on 8, 9,  and 10.  A gear like shape is drawn.
You should still have the ellipse.  Generate a 3D view to see them better.

• With the Skin ( ) tool (and the settings in the Skin Options dialog as before)
click on 11 and 12.  The ellipse is used as a source and the gear shape as a path,
producing the 3D object shown.
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• With the Ellipse by Major and Minor

Radius ( ) tool active click on 1, 2, and 3.
An ellipse is drawn.
• From the View menu select Top.
• Invoke the Polygon Options dialog

and select the Diamond (# Of Segments
= 4).  Make sure  Polygon Pattern is off.

• With the Polygon ( ) tool active click on 4 and 5.
• From the View menu select z=30˚ x=60˚.  In the 3D

view you can see the two shapes you drew.  Note that they
have two coincident points, which is appropriate.  One of the
shapes will be used as a source and the other as a path.

• Invoke the Skin Options dialog and select the following settings:
• Cross Skinning is on and # Of Sources is 1.
• Placement Type is By Current Position and Use Tolerance is off.

• With the Skin ( ) tool click on 6 and
7.  The shape you picked first (the ellipse)
is used as the source and the shape you
picked second (the diamond) is used as
a path.  The result is as shown.
• Undo and with the Skin tool click on 7,

then on 6.  Now the diamond is used as
source and the ellipse as path, producing
a different object, as shown.
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Sections of solids

Using the Section  tool ( ) on the 6th row, you can derive both 2D or 3D
sections of solid objects, and sets of 2D sections called contour lines .  For
these examples you will use the object derived with the sweep operation.

From the File menu select Close (and when you
are asked to save say "no").  This makes the
previous window, where the swept object (call it s)
is the active window.  We are ready to proceed.

•With the XY reference plane active ( ) draw
square a, roughly as shown.
•Switch to the ZX reference plane ( ) and

draw square b.
•Select the Section tool and, with topological

level set to Object, click on object s, then on
square a.  The result should be as shown.
•Undo and repeat the operation, this time click-

ing on s , then on b.

You have derived  a horizontal and a vertical 2D
section of object s.  The positions of the sections
were determined by surface objects a and b,
which function as cutting planes. You will next
repeat the operation and derive 3D sections of
the same object.

•Undo.
• Invoke the Section Options dialog (double

click on the Section tool) and select 3D.

•Select the Section tool, click on s, then on a.
The result should be as shown.

Your original object has been split into two pieces.
To verify this, you will move one of the pieces.

•From the 11th row, select the Move ( ) tool.
•Click on a segment of the top piece of your

object.  You notice that it is rubber banded and
follows the motion of the mouse.
•After moving the mouse by about one large grid

square to the left, click again.  This moves the top
piece.  (The Move tool and the other geometric
transformations are discussed on page 58.)

•Undo twice and repeat the operation, but this
time click on s and then on b.  This produces a
vertical cut through your object.  Again, use the
Move tool to pull the two pieces apart, as shown.
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•Undo twice.

You will now use the same object to generate
contour lines.  These are sets of 2D sections
that are generated with a single operation.
They are always parallel to the reference plane.
First, rotate the object by 90°, as shown.

• From the window tool palette, select the XY
reference plane, if it is not already active.

• Invoke the Section Options dialog, select
Contours, and click on OK.
• With the Section tool active, click on object s.

Observe the result, which is shown in both wire
frame and hidden line.  The contour lines are
parallel to the XY plane and are at increments
of 2', which is the default distance set in the
Section Options dialog.

•Undo, activate the YZ reference plane and
click on s.

Observe the result.  The contours are now
parallel to the YZ plane.  You can also generate
contours parallel to the ZX plane or any arbi-
trary plane, which you will do next.  You will first
define a new arbitrary plane and then generate
contours parallel to it.

•Undo.
• Set the topological level to Point.
• Activate the Define Reference Plane tool

(last row of the tool palette) and click on points
1, 2, and 3.  The arbitrary reference plane is
generated and its grid is displayed as shown.

• Invoke the Section Options dialog and in
the Use Contour Increment field enter 3'.
• Click on s and observe the result.

Without undoing, you will next generate  con-
tours parallel to YZ.  You will first unghost the
object to be able to pick it again.

• Select the Unghost tool and click on s.
• Invoke the Section Options dialog, and in

its Use Contour Increment field enter 10'.
• With the Section of Solid tool selected click

on object s.  The result, plotted in hidden line
mode,  should be as shown.
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s
Projection and unfolded objects

The Projection ( ) tool allows you to derive three varia-
tions of objects from projections of other objects.

•Undo four times to return the swept object s to its original
form.  We shall use it to illustrate the Projection tool.

• Double-click on the Projection ( ) tool to invoke  the 2D
Projection Type dialog and in it select Orthographic
Projection.  XY should be the active reference plane.
• With the Projection tool click on object s. It is projected

onto XY and one or more new objects are created.
•Undo, select the ZX Reference Plane ( ), and with the

Projection tool click on s.
You have derived 2D objects from the projections of solid s on two
reference planes.  The other projection type, Projection Of  View,
derives objects from the projection of a 3D view on to the reference plane.
You may want to try it.  We shall next derive unfolded projections.
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•Undo and in the 2D Projection Type dialog select Unfolded Projec-
tion.  Leave all the other options at their default settings.
• With the Projection tool click on 1.  Observe how object s is unfolded.  It is shown

below, left, in both a 3D and ortho view.
•Undo;  in the 2D Projection Type dialog select Generate Connectors.
• With the Projection  tool click on 2.  An ortho view of the result is shown, below,

right.

Note that the second time you selected s by clicking on a different segment
(2) than the first time (1).  Observe that each time s has unfolded differently.
Where you click determines the beginning of the unfolding and clicking on
different segments produces different unfolded patterns.

The second unfolded pattern also includes connectors at some of the
edges.  These can be used to reconnect edges if the pattern is printed on
cardboard and is refolded to construct a physical model.

Finally, you may want to experiment with unfolding other
objects.  For example, the object you generated with the
Cross Skinning operation a few sessions back is unfolded
as shown, when you click on the segment marked with the
bullet.
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Terrain models

Three types of terrain models can be de-
rived from contour lines and the bound-
aries of a site.  The contour lines may be
open or closed.  The site should be a
closed shape.  Both contours and site are
2D surface objects, which can be imported
or can be drawn in form•Z .

• Draw a site and a few contour lines,
roughly as shown in (a).
• Invoke the Terrain Model Options

dialog and select Adjust Heights.

• With the Pick ( ) tool click on the con-

tour lines in the order shown (1 through 7).

• Select the Terrain Model ( ) operator,

then click on the site.  The result should be as
shown in (b) from a z=30° x=60° view.

You have created a mesh terrain model
using the default increments (8') for the
mesh grid.  These increments can be
changed in the Mesh Options dialog,
which can be invoked from the Terrain
Model Options dialog or from the Mesh
tool.  Since all your contours were at 0
height, you also told the system to assign
elevations at 4' increments.  You will next
repeat the operation two more times using
exactly the same options, except for the
type of model.

• Invoke the Terrain Model dialog and
select Stepped Model.
•Undo and repeat the operation.  The

result should be as shown in (c).

• Invoke the dialog once again and select
Triangulated Contour Model.
•Undo and repeat the operation.  The

result should be as shown in (d).

Terrain models can also be generated on faces of solids and the three types
can be mixed, allowing the incorporation of landscape features such as
roads and  flat areas.  More details would be beyond the scope of this Mini
Manual.  However, if terrain modeling is your main area of interest, call us
at auto•des•sys and we shall be glad to send you more detailed instructions.

Controlled curves (c-curves)

Ten different types of curves can be generated using the Create/Edit C-

Curve ( ) tool (first on the 7th row of the tool palette). These curves are

generated from vector lines, called control lines , which are drawn first.
Their shape is also affected  by other controls, such as weights  and knots ,
and the parameters which are selected from the Controlled Curve
Options dialog.  They are called controlled curves because they are
internally stored with the controls and parameters that generated them,
which makes it easy to edit and reshape them after their initial generation.

In the dialog, the types of curves are organized into two groups.  The upper group
includes the NURBS, B-Splines, and three variations of Bezier.  These curves allow
more extensive control of their parameters, but they have higher computational
demands and are slower.  The lower group includes two types of "quick" Bezier and
three variations of tangent curves.  These curves are restricted to the 2nd and 3rd
degrees (the highest exponent in the mathematical formula that generates them).
Their generation is thus faster and more interactive.  Except for very specialized
applications, the quick curves will do the job in most cases.

• Draw a vector line roughly as shown.
• Select the C-Curve tool and click on it.

By default, the system has generated a quick
quadratic curve (composite 2nd degree
Bezier) and has entered the c-curve edit
mode.  As you move the mouse about the
control line the mouse cursor changes.  For

example, it becomes , , and   when
you are on a point, a segment, and a knot,
respectively (see labels on the right).  When
the cursor changes and you click, you select
the corresponding entity which starts to move.
The next mouse click repositions the se-
lected entity.  You can continue editing the
shape of the curve until you double click (or
you click on the tool palette) which exits the
edit mode.  Different special keys on the
keyboard can be used to access additional
editing operations.  In the Controlled
Curve Options dialog you can also select
the Construct Directly option which
causes the curves to be generated without
editing.  Try both options and repeat the
operation once for each type of curve to
observe the differences.  Some examples
are shown on the right.

NURBS
Bezier
Broken Bezier

Quick Cubic
Tangent

control point
control segment
knot

    7 6 5 4    3   2         1 (a)

(b)

(c)

(d)
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length depth

length segment
point

depth segment
length line

depth line

• From the View menu select Front to go to the
ZX projection view and draw three lines. The lines
should be drawn in the same direction as shown.
• Next select the 30/60 view and move two of the

lines to position them roughly as shown.
• With topological level at Object, use the Pick tool

to pick the three lines from back to front.
• Select the Create C-Mesh tool and click the

mouse in the graphics window.

A mesh appears on your screen and on top of it
another structure (shown in red) called the control
net .  The system enters the c-mesh edit mode. The
net is for the c-meshes what the control lines are
for the c-curves.  Its parts can be moved interac-
tively to reshape the mesh.  As you move your
mouse around the net, you again notice that its

cursor changes.  It becomes   when on a point,

 when on a length segment, and  when on a
depth segment.  When you press the control  key
on the Macintosh or the ctrl+alt  keys on Windows
as you place the cursor on a length or depth

segment, it changes to    and  ,  respectively,
indicating that the complete length and depth lines
are selected. The direction along the control lines
picked for the generation of the mesh is called the
length  of the mesh.  The direction across the
control lines is called its depth .  The distinction is
significant, especially when you select parameters
from the Controlled Mesh Options dialog.  In
the example, we used the default parameters.
While in the edit mode, we moved the two front
corner points in the X direction, and the middle
segment at the rear of the net up, after selecting
the Perpendicular switch from the window tools.

Controlled meshes (c-meshes)
Meshes are surfaces subdivided to smaller pieces, usually called patches .
form•Z  offers you plain meshes (discussed in the next section) and
controlled meshes (c-meshes ).  The latter are similar to the c-curves in that
they are internally stored with the controls that generate them, and thus can
easily be edited and reshaped after their initial creation.  There are two tools

that operate on c-meshes: Create C-Mesh ( ), used to generate new

meshes, and Edit C-Mesh ( ), used to reshape existing c-meshes.
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Note that while in the c-mesh edit mode the tool palette is grayed out to
indicate that it is inactive.  The window palette remains active and its
operators complement the c-mesh editing process.  You exit the edit mode
by double clicking away from the mesh or by clicking on the tool palette.
When you do, the mesh reappears in its final form and without  its controls.

The Edit C-Mesh tool can be used to reenter the c-mesh edit mode in order
to manipulate the shape of the mesh further.  You do this by selecting the
Edit C-Mesh tool, and clicking on the mesh.  You also want to be sure  to
select  Adjust To New Parameters in the Controlled Mesh
Options dialog.   Both the Create and Edit C-Mesh tools can be used in
a direct  fashion, without editing, as you will do in the next example.

•Switch to the Top view and draw six concentric squares, roughly as
shown.  The first point of each square should be the lower left corner.  Then
switch to a 3D view (such as the 30/60) and, after selecting the Perpendicu-
lar switch, move and position the squares roughly as shown.  You may also
go to the Front view to move them there, as we show to the right.

• Invoke the Controlled Mesh Options dialog (double click on either
of the c-mesh tools) and in it select Construct Directly.  Click on the
Type Of Object... button to invoke its dialog and in it select Two Sided.
•Make sure that your topological level is set to Object, and use the Pick

tool to select the squares in order (bottom to top).
•Select the Create C-Mesh tool and click the mouse anywhere in the

graphics window.  A meshed "vase" appears on your screen directly and
the system does not enter the edit mode.  Below, it is shown in wire frame
(left) and hidden line (center) plots.  You will next increase its density.
• Invoke the dialog again and in the # Of Segments field in the Mesh
Length  column enter 40.  In the same field of the Mesh Depth  column
enter 5 and select the Per Segment option.
•Undo, and execute the operation again.  The result should be as shown.
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Plain meshes

Plain meshes are generated on closed surface
objects (2D shapes) or on the faces of solids,

using the Mesh tool ( ).

• On the XY plane, draw a rectangle and a
hexagon, roughly as shown.
• With topological level on Object, select the

Mesh tool and click on 1, then 2.  Where you
clicked determined the direction of the mesh.
The density of the mesh is controlled by param-
eters in the Mesh Options dialog.

• Invoke the Mesh Options dialog (double
click on the tool), and select From Angle.
• With the Mesh tool active, click on 1 and 2.

Observe the result.  With the From Angle
option selected, where you pick the object is
insignificant.  The mesh direction is determined
by the Altitude and Azimuth parameters.

Undo to clear the screen (4 times), then gener-
ate two solid versions of your previous objects.

• Invoke the Pick Options dialog (double click
on the Pick tool) and select the Clicking In-
side Boundaries option (the single click face
pick option).
• Set the topological level to Face.
• Invoke the Mesh Options dialog and set the
X, Y, and Z fields to 4'.  Select Center On Line,
and From Picked Segment.
• With the Mesh tool active, click on point 3,

then 4, then 5 and 6.  Observe the results.

• Invoke the Mesh Options dialog again and
set the X, Y, and Z fields to 1'.
• With the Mesh tool active, click on 7, 8, and 9.

Observe the results.

Undo to return to the original objects.  You will
now generate meshes on the complete objects.

• Set the topological level to Object.
• Invoke the Mesh Options dialog and set the
X, Y, and Z fields to 4'.
• With the Mesh tool selected, click on each of

the objects (points 10 and 11).

3
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Smooth meshes
Smoothly curved meshes can also be generated on faces or complete objects

using the Smooth Mesh ( ) tool.  You will do a few examples in this session.

•Undo twice to return to the original objects used in the previous section.
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• Invoke the Smooth Meshing dialog and in it:
• deselect Edit,
• set Maximum # Of Subdivisions to 2, and
• select Keep Flat.

• With the Smooth Mesh tool active, click on 10, then
on 11 and observe the results.
The two solids are meshed in a different manner than they were in
the previous example.  They are meshed by subdividing its faces
as many times as indicated by the # Of Subdivisions param-
eter, rather than imposing a rectangular grid, as is done by the
Mesh tool.

•Undo twice, invoke the Smooth Meshing
Options dialog and select Smooth.  Keep all the
other options at their default values.
• With the Smooth Mesh tool click on 10 and 11.

Observe the result.  The same mesh is generated as before, but the mesh is now also curved resulting
in smoothly displaced surfaces.

•Undo twice and in the Smooth Meshing
Options dialog set Maximum # Of Subdivi-
sions to 3.
• With the Smooth Mesh tool click on 10 and 11.

Observe that  now the faces are subdivided three times resulting
in a deeper mesh.

•Undo twice and in the Smooth Meshing
Options dialog set Curvature to 5%.
• With the Smooth Mesh tool click on the objects.

Observe that 5% curvature produces less rounded objects.  You may want to
experiment with a value at the other end, that is, something  like 90% and see
how it affects the roundness of the resulting mesh.

The examples we did so far in this session are
relatively simple.  More complex objects can also be
smooth meshed, as shown by the last example.  The
3D cross-like object is derived from three cuboids
unioned together.  You may want to come back and
do this example after you learn about the Booleans,
which are covered a bit later in this Mini Manual.
Once you have the 3D cross object, you smooth
mesh it by simply clicking on it with the Smooth Mesh
tool.  We used Maximum # Of Subdivisions 3
and Curvature 50%.  All the other options were
with their default values.
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Deformations

Three types of deformation can be applied to surfaces and objects using the
Deform tool: mesh movements , point disturbances  and object defor-
mations .  The deformation type is selected from the Deformation
Options dialog, invoked directly from the Deform tool ( ).

You will first do a mesh movement, whose form will
be determined by a profile selected from the Pro-
files palette.  A profile is a 2D open shape that is
drawn in the usual manner, and then stored in the

Profiles Library using the Define Profile tool ( ).
Saved profiles are accessible through the Profiles
Palette shown on the right. In the Palettes menu,
select the Profiles item.  When the Profiles palette
appears, it contains six default profiles.  For this
example, use the upper left profile to execute a
mesh movement.  Click in the upper left box.  The
box is highlighted to indicate the active profile.

• Draw a square on the boundaries of the grid and,
after selecting 2' increments in the Mesh Options
dialog, generate a mesh as shown.
• Select the Perpendicular switch ( ).

• Select the Deform tool ( ) and click on the point
marked.  This  rubber bands a polygon.
• Position the polygon roughly as shown and click

again. This rubber bands a 3D bell shape, which
follows the perpendicular motion of the mouse.
• Position it at the desired height and click again.

This regenerates the surface, an area of which has
been moved smoothly, following the shape of the
profile.

You can apply multiple mesh moves on one surface, as two of the examples
below show.  You can also apply linear mesh moves as opposed to the
radial  just executed.  These and other options are selected from the Move
Mesh Options dialog, invoked from the Deformation Options dialog.
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The Deform tool can also be used to generate both random and regular
disturbances to surfaces and objects.

•Undo to return to your original meshed
square.
• Invoke the Deformation Options

dialog, and select Disturb Points.
Click on the mesh, and observe the
results.

You have applied a Random Distur-
bance to the points of the mesh, the
default option in the Disturb Point
Options dialog.

You will next execute wave disturbances,
first of a linear, then of a circular shape.

•Undo, and invoke the Deforma-
tion Options dialog.  Click on the
Disturb Point Options... button to
invoke the respective dialog, and select
Wave Disturbance.  Exit the dialog.
•With the Deform tool active, click on

the mesh, near the point marked with
the dot.  A linear wave, which is the
default type, is generated.
•Undo.  Invoke the Disturb Point
Options dialog, and next to Type, se-
lect Circular.  Exit the dialog.
•Click on the point marked with the dot

again.  Observe the result.
•Undo, and in the Disturb Point
Options dialog, select Through Cen-
troid.
•With the Deform tool active, click on

the marked point again, and observe
the result.

Note that in the previous example, where you clicked was significant, and
determined the center of the wave.  In the second example, it was not
significant, and the center of the wave was positioned at the centroid of the
surface.

The Disturb Points operation can be used to apply both random and
regular point disturbances to both surfaces and objects.  The operation
works best on relatively dense meshes.
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Using the Deform tool, objects can be deformed interactively, both individu-
ally, and as groups of selected objects.  Undo to clear the screen, and
generate the shown conic mesh as follows:
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• Draw two concentric circles as shown
(make certain that they are drawn in the
same direction).
• Turn on the Perpendicular Switch, then,

with the Move tool active, move the small
circle up roughly as shown.
• In the Controlled Mesh Options dia-

log, select Construct Directly.  Under
Mesh Length, select At Control Points
and deselect Smooth.  For Mesh Depth,
select # Of Segments, and in its field enter
20'.
• With the Create C-Mesh tool active, click

on the large and then on the small circle.

The resulting meshed cone should be roughly
as shown.  You can now apply some defor-
mations to it.

• Invoke the Deformation Options dia-
log, and select Deform Object, and Bulge.
Exit the dialog, and click on the object.

A bounding box appears which defines the
area that will be deformed.  This box can be
rotated and its top and bottom ends can be
moved.  You will next move its top end.

• While pressing the option key on the
Macintosh or the ctrl+shft  keys on Win-
dows, place the cursor on one of the horizon-
tal edges of the top of the box.  When the

cursor changes to , click on 1.
• Move the cursor down, and click on 2.  This

moves the top end of the bounding box
down.
• Position the cursor on one of the corner

points of the top end of the bounding box
(causing the cursor to change to  ), and
click on 3.
• Move the cursor away and click on 4.

2

1

Observe how the Bulge operation deformed the lower portion of your
object.  You will next bend your object.
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You have just observed how different types of Bezier
bendings can be executed by pressing different keys
while your bounding box is rubber banded.

You have tried three of the seven available object
deformations.  You may wish to experiment with the
others on your own.

Macintosh: no key shift control option command

Windows: no key shift ctrl+alt ctrl+shft ctrl

•Undo, invoke the Deformation Option dialog,
and select Radial Bend.
•Click on the object.
•When the bounding box appears, click on a segment

of its top end (point 5).
•As the bounding box rubber bands, move the mouse

in a circular direction until the bounding box makes about
a 270° turn (three quarters of a circle), and click.

Observe how the object has been bent.

You will next bend your object in a different way.

•Undo, and in the Deformation Options dialog
select Bezier Bend.
•Click on the object to select it.
•When the bounding box appears, click on a segment

of its top end (point 6), and move the mouse in different
directions to observe how it deforms.
•Press the shift key, and move the mouse again.  Do

not click the mouse yet.
•Press the control key on the Macintosh or the ctrl+alt

keys on Windows and move the mouse.
•Press the option key on the Macintosh or the ctrl+shft

keys on Windows and move the mouse.
•Press the command key on the Macintosh or the ctrl

key on Windows, move the mouse until you get a
deformed shape that you like, and click.

Your meshed cone is deformed and takes a shape
analogous to the deformed bounding box.

6
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Rounding

Vertices and edges, including concave corners, can be rounded individu-
ally or simultaneously using the Plain Rounding method.  Controlled
Rounding is also available, which allows you to preview the effects of the
rounding parameters, then edit and interactively change them.  In addition,
Plain and Controlled Rounding can be used to derive different results.

The Rounding tool ( ) will be illustrated by the following examples.

• Generate an 8' x 8' x 10' cuboid, as shown.
• Invoke the Rounding Options dialog.  Se-

lect Plain Rounding and Corner Point.
• With topological level set to Point and the

Round tool active, click on point 1.
•Undo, invoke the Rounding Options dialog,

select Edge and repeat the operation.
•Undo, in the Rounding Options dialog se-

lect Edges & Points and repeat the operation.

Observe the results which should be as shown.

•Undo, invoke the Rounding Options dialog
and in the Use Radius field type 2'.
• Set the topological level to Segment and with

the Pick tool active, click on points 2, 3, 4, and 5,
to prepick the respective segments.
• Activate the Round tool and click on the screen.
•Undo, preselect segments as before but this

time also include segment 6, and with the Round
tool active click on the screen.

Observe the results. Points can only be rounded
when the segments that converge to them are
also rounded.

The Rounding tool can also handle concave
points.  To illustrate, first create an object roughly
as shown (two cuboids differenced).  Such an
object contains convex , concave , and mixed
points that behave differently when rounding is
applied to them.

• In the Rounding Options dialog select Cor-
ner Point.  (Plain Rounding is still selected).
• With topological level at Object and the Round

tool active click on your object (point 7).
•Undo, in the Rounding Options dialog se-

lect Edge, and repeat the operation.
•Undo, in the Rounding Options dialog se-

lect Edges & Points, and repeat the operation.
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Plain rounding can apply only one type of operation at a time, and only
uniform parameters.  In contrast, controlled rounding allows you to mix
rounding types and parameters, and  remembers the rounding parameters
applied earlier and allows you to change them.  Controlled Rounding
is selected from the Rounding Options dialog and is applied through a
preview dialog, as the following examples will illustrate.

•Generate an extruded hexagon, roughly as shown.
• Invoke the Rounding Options dialog and se-

lect Controlled Rounding.
•With the Round tool active, click on the hexagon.

The Rounding Preview dialog appears.  It con-
sists of a preview window where the hexagon is
shown, buttons, and numeric fields.  The Round
Radius option should be selected, 4'-0" should
appear in its field, and 4 in the # Of Points field.
•Click on point 1, then on the Preview button.

Observe the result.  When you clicked on the front
top segment of your hexagonal solid, it was high-
lighted.  When you selected Preview your object
was redrawn with its front top edge rounded.

• In the Round Radius field enter 2', click on point
1 again, and click on Preview.  Then click on OK.

The Rounding Preview dialog goes away and
your object is generated as it was in the preview.

•With the Round tool active, click on the object.

The Rounding Preview dialog appears again
and your hexagonal solid is shown in the preview as
it was the last time you closed the dialog.  You will
next round the remaining segments of the top face,
by applying different rounding parameters.

•Change the Round Radius field to 4'-0" and
click on 2 and 3.
•Change the Round Radius field to 6'-0" and

click on 4 and 5.
•Change the Round Radius field to 8'-0" and

click on 6.
•Click on Preview, then click on OK.

You have rounded the segments of the top face of
your object by applying variable size radii, starting
with 2' and going up to 8'.  Variable rounding radii
can only be applied through controlled rounding.
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Draft angles

The draft angles are slight tapers that are applied to faces of objects, to
facilitate their manufacturing when injection molding is used.  In form•Z

they can be applied using the Draft Angle ( ) tool.  While this tool is
intended to be used on models that are exported for molding, it can also be
used to derive tapered forms, as the following example illustrates.

• From the Edit menu, Clear to start
fresh.
• With the XY Reference Plane active,

draw a cuboid, a cylinder, and an ex-
truded star (patterned polygon), roughly
as shown.  They are all 20' high.

• Double-click on the Draft Angle ( )
tool to invoke the Draft Angle Op-
tions dialog.  In it set Inclination
Angle to 10˚.  Leave all the other options
with their default values.
• With the Draft Angle tool active, click

on each of the three objects and observe
the results.
•Undo three times.
• Select the YZ Reference Plane.
• Invoke the Draft Angle Options

dialog and in it select At Minimum Of
Objects/Faces and set Inclination
Angle to 20˚.
• With the Draft Angle tool click on each

of the objects and observe the results.

You have created shapes which are other-
wise hard to generate.  You have actually
used the Draft Angle tool in a rather exag-
gerated mode. The example on the left
shows a more typical use of draft angles.

A "shell" object is created as
shown.  This is a 3D enclosure
with its bottom closed and its
lower edges and points rounded.
We apply a draft angle by click-
ing on it with the respective tool,
while the XY Reference Plane is
active.  Applying a draft angle to
its open (top) ends makes pulling
it off the molding form easier.
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Spherical objects

The eight types of spherical objects shown below can be generated with the

Spherical Objects tool ( ), using one of three available placement
methods.   You will first generate a geodesic sphere, using the Origin And
Uniform Scale method (default ).

•With the Spherical Object tool active, click in the
graphics window, then move the mouse.

If you move the mouse quickly, a bounding box is rubber
banded.  If you move it slowly, a spherical object is rubber
banded.  In both cases, as you move the mouse the size of the
object grows or shrinks.

•When you have the desired size, click again.

This generates a geodesic sphere, as shown.  You will next
repeat the operation and generate a higher density sphere.

• Invoke the Spherical Solid Options dialog.  Make
sure that the # Of Levels option is selected, and in its
field enter 3.  Repeat the operation as above.  After the
second click of the mouse, and a momentary pause, a
geodesic sphere of higher density is generated.

You will next generate a lathed sphere using the Cen-
ter & Radius, Height, Rotation method, which
allows you to scale any of the dimensions of the sphere
independently of the others to produce elliptical shapes.

• In the Spherical Solid Options dialog, select
Revolved Sphere and the Center & Radius,
Height, Rotation method.
•Click in the graphics window.  A 2D shape is rubber

banded.
•Click the mouse again when you have reached the

shape you desire.  A 3D shape is rubber banded.  Click
again.  The size and shape of your object is defined, and
the motion of the mouse rotates the object about the Z
axis.
•When you are satisfied with its position, click again.

This completes the operation.  Note that when the final sphere is generated, its
density is determined by the values entered in the Length and Depth Resolution
fields, while a lower density is used for the rubber banded form.
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B

union

difference A-B

A

intersection

difference B-A

Boolean operations

Generate two cuboids, as shown.  Make the first
higher than the second by selecting different height
values from the Heights menu.  Make sure that the
two volumes partially overlap.

• Select the Union operator ( ), then click on each
of the two objects, and observe the result.
•Undo and repeat the operation after selecting the

Intersection operator ( ).

•Undo again and repeat the operation by selecting

the Difference operator ( ).  As shown by the last
two images, the difference is sensitive to the order in
which the objects are selected, and will give different
results, depending on which object is selected first.

The Boolean operations can also be used with 2D
surface objects.  However, surface and solid objects
cannot be mixed.

The Boolean Split ( ) is  a composite operation.  It
can be executed in a one or two way mode, as
selected from the Split Options  dialog.  As an
example, turn on the Grid Snap and generate the
object shown below in (a).  It is drawn in Front view,
as shown in (b).  Then use the Rotate tool to make one
more copy, as shown in (c).  Try to be as accurate as
you can in order to produce the results we show.

• Invoke the Split Options dialog and select Two Way.
• Select the Split tool and click on each of the two

objects.  To be able to see the result, move  the pieces
roughly as we did in (e).
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You can also trim or split a mesh using a line as a second object.  This is
illustrated below.  You can also apply these operations to solid objects or
combined surface and solid objects.

Trimming and stitching

From the Trim & Stitch ( ) tool you can invoke

the Trim, Split & Stitch dialog from which
eleven different variations of these operations can
be selected.
Note that these operations resemble the Booleans in that they
calculate the intersection of objects.  However, you have to tell
them which pieces to return for the result, which you do by where
you click.

•Generate two surface (single sided) meshes,
roughly as shown to the right.  Make certain that
the cylindrical mesh penetrates  the open surface.
•Set the topological level to Object.
•Select  the Trim & Stitch tool and click on point

1, then 2.  Actually the position of the second click
is insignificant for this operation.  However,  the
position of the first click is very significant since it
determines which portion of the first surface will be
kept after it is trimmed by the second.

• Invoke the Trim, Split & Stitch dialog and
select Split in the Both Objects column.
•Undo and repeat the operation.  Observe the

results.  To be able to better tell what happened,
move the resulting pieces apart.

The trim operation cuts a piece away, while the split
operation cuts a mesh into two or more pieces.
When an option in the Both Objects column is
selected, then the operation is executed two ways.
That is, each object is trimmed or split by the other.

• Invoke the Trim, Split & Stitch dialog and
select Trim & Stitch in the Both Objects
column.
•Undo and repeat the operation.  Observe the

results.  Corresponding pieces of the two meshes
have been joined together, which is the result of
the stitch operation.
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Joining and separating
After the Boolean and the Trim & Stitch tools on the 8th row of the tool palette are

the Join ( ) and Separate ( ) tools.  Join merges two or more objects into one,

without calculating their intersections, which the Booleans do.  That is, one or more
objects become "volumes" of a single object.  Separate does exactly the opposite;
when applied to objects that consist of more than one volumes, it produces a
separate object for each of the volumes.  However, the Separate operation can
also be used to "split" an object into pieces, as illustrated by the following examples.

• Draw a cylinder, roughly as
shown.  It's exact size does not
really matter.
• Double click on the Sepa-

rate tool to invoke the Sepa-
rate Options dialog.  In it
select Along Stitch.
• With the Separate tool ac-

tive, click on 1 and then on 2.
There is no visible effect, but the top and bottom faces of the cylinder have
been separated.  To see them, turn on the Perpendicular Switch and with
the Move tool move them up and down as we show.

• Invoke the Pick Options dialog and select Clicking Inside Boundaries.

• On the 4th row, set the topological level to Face ( ).

• With the Pick ( ) tool active click on 3, 4, 5, and 6.  The faces on which these
points lie turn red indicating that they have been selected.
• In Separate Options dialog select At Boundary Of Selected Faces.
• With the Separate tool active, click somewhere in the graphics window.

Again, there is no immediate visible result.  However, the four preselected faces have been separated
and have become an independent object.  To see them, move them as we did in the example before.

• In the Separate Options dialog select Along Selected Segments.
• With the Separate tool click on 7.

The main body of the cylinder has been separated to two pieces.  Move one, as we show, to see the result.

To do a few more examples, generate the meshed surface you did for the c-mesh
example, earlier (page 34).  It should be roughly as shown below.

• With topological level at Segment ( ) preselect the sequence of
segments labeled 8.  Along Selected Segments should still be on in the
Separate Options dialog.  With the Separate tool click in the window.

• Preselect the group of faces
labeled 9, select At Bound-
ary Of Faces in the dialog
and with the Separate tool
click in the graphics window.
Move the pieces that were sepa-
rated, as we did, to see them better.

1

2 3 4 5 6
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9

Grouping and ungrouping

The Group ( ) operation links a number of objects,

without transforming them into a single object.  While Group
does not produce a visible effect, its effects can be ob-
served in the Objects palette, as we see below.
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• Generate a cube, a pyramid, and an octahedron roughly as shown.
Their size and shape are not really important for this example.  Observe
how they are listed in the Objects palette with default names "Object 1",
"Object 2", etc.  Change the names to "Cube", "Pyramid", and
"Octahedr" (or whatever names you prefer) to make them easier to
distinguish.  You change these names by clicking on a name field in the
Objects palette to highlight them, typing a new name, and clicking in the
palette away from the name you just changed.

•Make three copies from each of the objects;  observe
how the names are listed in the palette.
•While pressing option  (Mac) or ctrl+shft  (Wins)

click on the palette to invoke the Objects dialog.  In it
click on Sort.  The names have been sorted.

•Make sure that topological level is at Object ( ) or

Group ( ); with Pick preselect the four cubes.

•With the Group ( ) tool click in the window.

While no visible change can be observed on the objects (other than
that they are not highlighted anymore) there is a visible change in the
Objects palette.  A group called Group 1 has been created and the four
cubes have been placed in it.

You can also execute grouping operations by working directly in the palette.

• Click under the last name in the Objects palette.  The name Group 2 appears.
Click under it to complete the creation of a new group, which is initially empty.  You
will next put some objects into this group.

• Click on "Octahedr", drag it onto "Group 2",
and release it.  It is placed into Group 2 as shown.
• Drag "Octahedr Copy", "Pyramid", and "Pyra-

mid Copy" into "Group 2".
• In the Objects palette, click in the column in

front of "Group 2".  Check marks are displayed in
front of "Group 2" and its members, which are
also highlighted red in the graphics window.

• With the Ghost ( ) tool, click in the window.

The four objects in Group 2 are ghosted.  They are displayed in the gray
ghost color and the diamonds in the visibility column of the objects palette
have been switched to white diamonds.

In form•Z , groups, which may be structured at any depth, facilitate a variety
a operations, such as exporting.  In addition, they take a special meaning
when used in conjunction with metaformz, as illustrated in the next section.
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Metaformz
The metaformz, which include the metaballs, are a special type of paramet-
ric objects that have the ability to blend smoothly together, when they
overlap.  Thus they lend themselves nicely for the modeling of irregular,
organic forms.  As an example, we shall model a bone.

• Use the Vector Line ( ) tool to draw a line,
roughly as shown.

• With the Derive/Edit Metaformz ( ) tool
click on the line.  This causes the Metaformz
Parameters dialog to be invoked.  In it select
Conic Tube (from the Metaformz Type
pop up menu, and enter 8' and 6' in the Radius
1 and Radius 2 fields, respectively.  Observe
the result.
You have derived a metaform of type conic tube from a single
line.  This metaform is displayed through wire frames, which
is its unevaluated representation.  It will soon be evaluated
to derive its meshed surface.  However, before we evaluate
it we shall generate four more metaformz.  These will be
metaballs, which are spherical shapes generated directly,
as opposed to being derived from other objects (as the conic
tube was).

• From the View menu select Top (take
another look at the conic tube).

• Double click on the Create Metaballs ( )
tool to invoke the Metaball Type dialog.  In
it select Ball (if not already selected) and enter
3 for Weight.
• With the Create Metaballs tool click on 1 and

2.  This creates a metaball, as shown in an
ortho view.
• Continue and with the Create Metaballs tool

generate three more metaballs, roughly as
shown.
• From the View menu select z=30° x=60° .

You now have a 3D view of your five metaformz.  Note that,
in the Objects palette their names are displayed blue, which
distinguishes them from the regular form•Z  objects.

• Click in front of each name in the Objects
palette to select the five metaformz.

• With the Group ( ) tool click in the window.
The Metaformz Evaluation Parameters
dialog is invoked.  Leave all options at their
default settings and click OK.
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Your five metaformz have been evaluated into a continuous
mesh, which smoothly blends all five metaformz.  Also note
the changes made in the Objects palette.  The five metaformz
have been placed under Group 1 (as expected), and at the
top of the group a new name "Metaform Mesh - Group 1" has
appeared.  This is the name of the evaluated metaformz,
while the group name (Group 1) is the name of the unevaluated
group of metaformz.

•From the Display menu select Hidden
Line* to see the blended shape better.

•With the Metaformz Evaluate ( ) tool click
on the evaluated metaformz.  When the
Metaformz Evaluation Parameters
dialog is invoked change the Threshold value
to 90% and the Mesh Resolution to 1'.
As soon as you exit the dialog, the metaformz are reevalu-
ated.  Generate a hidden line plot again and observe the
effects of the options you just changed.

Next, you may move slightly any of the four metaballs or use
the Scale tool to resize them.  Assuming you have not
changed the default option in the Metaformz Evalua-
tion Options dialog, each time you execute one of these
operations your metaformz will be reevaluated and the
blended mesh will change.  We show a version of our bone,
after applying a number of Scale and Move operations.

The latter paragraph describes the typical metaformz modeling process, which is mostly visual.
That is, you create a few metaformz, you evaluate them, you visually inspect the results, you make
changes, you reevaluate them, and so on, until a satisfactory shape has been derived.

As another example we show a head of a mouse.  The
main head is derived from four metaballs, evaluated as
for the example above.

The ears are modeled and evaluated a bit differently.
You start with two circles.  You use the Derive/Edit

Metaformz ( ) tool and derive metaformz of type
sheet from them.  For the first sheet you use Weight
= 1; for the second you use Weight = -1.  You move the
second sheet so that it overlaps the first just a bit. When
the two are evaluated together, the second metaform
has  a subtractive effect, creating the "ear", as shown.

Finally note that the "nose" is a single metaball and that
the ears and the nose are kept as independent objects.
That is, they are not grouped with the rest of the head.
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Observe the results.  Two text strings that spell "<Text>" (in the default font)
are plotted on the screen.  "<Text>" is the default string that shows up in the
text field of the 3D Text Editor dialog.  Since you did not change it, it was
plotted as is.  The two text entities shown on the screen look identical, but
are of different types.  The lower is plain text, while the upper string is object
text, which can be changed to a solid object.  You will next change the text
string, change the text to a solid object, and rotate the individual characters.

• Select the Edit Text icon and click on point 3 to select the text object.
• When the 3D Text Editor dialog appears, in its text field type "Angled

Text."  You do this using the standard text editing procedures.

• From the Object Type pop-up menu, se-
lect Solid, turn on the Standing (Perp To
Plane) option,  in the Character Angle field
type 45°, and click on OK.

Observe the result.

3D text

Three tools on the 9th row of the modeling tool palette allow you to place

and edit 3D text ( , , ).  Text can be generated as plain   or object
text, which can be a one or two-sided surface   or solid object.  Text objects
are typically generated as controlled objects which can be edited and
changed after their initial creation.

The type of text is selected in the Text Placement dialog, which can be
invoked directly from the Place Text tool (double click on it).  The Place Text

tool ( ) is used to create a new text entity.  Controlled text objects are

edited and changed using the Edit Text tool ( ).  Text can also be created

along or between control lines, whose shape can be changed using the

Text Line Edit tool ( ).  When using the Place Text and Edit Text tools,

when the mouse is clicked on the screen, the 3D Text Editor dialog
appears, where the text string is typed and other options are selected.  You
will first generate plain and then object text.

• Invoke the Text Placement dialog, and
under Plain Text select Text At Point.
• With the Place Text tool active, click on 1.
• When the 3D Text Editor dialog appears,

ignore it and click on OK.  Observe the result.
• Invoke the Text Placement dialog again

and under Text As Object select Text At
Point.
• Click on point 2.
• In the 3D Text Editor dialog under Object
Type select Surface, and click on OK.
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Observe the results.  Your text string has been generated following the
control lines, and is unfolding in 3D space.

Text can also be placed along a control line,
which you will do next.  You will first draw the
line, and then place the text.

• Using the Vector Line tool, draw a line
roughly as shown.  It begins at point 1 and
ends at 2 (the direction is significant).
• Invoke the Place Text dialog, and under
Text As Object Along Path, select On
Line, Scale Height & Width, and  Bezier
Smooth Line.  Click on OK.
• With the Place Text tool active,  click on

the line (point 3).
• When the 3D Text Editor dialog ap-

pears, type the alphabet in its text field.
Solid and Standing (Perp to Plane)
should still be selected.  Click on OK.

 Observe the result.  You will next generate
text between two control lines.

•Undo or Delete to clear the screen.

• On the XY reference plane, draw two open
lines from left to right, roughly as shown.
• Turn the Perpendicular switch (  ) on by

clicking on it.  It is in the window tool palette.
• Select the Move tool and click on 4, then 5.

This moves the top control line up in a
direction perpendicular to the XY plane.

• Turn off the Perpendicular switch.

These are the two control lines between
which you will place text.

• Invoke the Place Text dialog and under
Text As Object Along Path, select Be-
tween Lines.  Select Bezier Smooth
Line and click on OK.
• With the Place Text icon active, click on 6

and 7 to select the two lines between which
the text will be generated.  The 3D Text
Editor dialog appears.
• In the text field of the dialog, type "Curved

text."  From the Object Type pop-up menu
select Surface, and click on OK.
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You will next edit and change the shape of your control lines, and watch how
the shape of your text will also change.

• Select the Text Line Edit tool, and click on the
text object  (point 1).

You have entered a line edit mode: the tool
palette is grayed out, and the control lines of
your curved text appear.

• Click on 2 to select the bottom control line.

The cursor changes to  and the control
points of your line appear.  In the Text Line Edit
mode, you edit the control lines that determine
the shape of your text object.  These are edited
the same way as common control lines (see
page 33 of this Manual).  You will first move the
left endpoint of the bottom line.

• Click on 3, then 4.

This  reshapes the curvature of the line, roughly
as shown.  The shape of the text has not yet
changed.  It will change if you click once on the
screen, click on the other control line to select
it, or double click on the screen to exit  the edit
mode.

• Click on 5 to select the other control line.

The text is regenerated in its new shape, the
lower control line returns to normal, and the
upper control line is now shown with its control
points which can be moved.

• Click on 6 to select the middle point of the
line, then click on point 7 to reposition it.
• Double click on the screen.

 You have exited the Line Edit mode and your
text object has been generated in its final form.
Note that it is a surface object.  To complete this
example, you will edit the text object once
again to change it to a solid object.

• With the Text Edit tool selected, click on the
text object (point  8).
• In the 3D Text Editor dialog, from the
Object Type pop-up menu select Solid.  In
the Depth field type 1'-6" and click on OK.

Your 3D text is regenerated as a solid object.
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•Use the appropriate object generating tools
to create two cuboids, two surface solids, two
rectangles, and two open lines, roughly as
shown.
• Invoke the Parallel Objects dialog and

make certain that the defaults Single Paral-
lel (Surface) and Out are selected.
•With Parallel Object active click on 1, 2, 3,

and 4 (on each of the objects on the back row).

Observe the results.  Parallel copies of the
original objects have been generated at a
preset distance.

• Invoke the Parallel Objects dialog again
and select Double Parallel and Center.
•Click on 5, 6, 7, and 8.

Observe the result.  Parallel surfaces have been generated
on both sides of the original objects and, except for the open
line, they are connected to form a single solid object.

For the next example, recreate the mesh from
page 34 of this Manual, as shown.  Select the
control lines back to front so that the positive
(visible) side of the mesh is on the top.

• Invoke the Parallel Objects dialog and
select Single Parallel (Surface), Out and
in the Wall Offset: Out field type 4'.
•With the Parallel Object tool active, click on

9 and observe the result.
• Invoke the Parallel Objects dialog and

select  Double Parallel, Center, and in the
Wall Offset: Out and In fields enter 2'.
•Undo and with the Parallel Object tool active

click on 9 again.

Parallel objects

The Parallel Object tool ( ) in the 6th row of the tool palette can be used
to derive parallel objects from other objects.  The original object can be a
solid, a one or two-sided surface, or an open vector line.  Both single and
double parallel objects can be created.  The type of parallel object to be
created, as well as a number of other parameters, is selected from the
Parallel Objects dialog which can be invoked directly from the Parallel
Object tool (double click on the icon).  In this section you will first generate
single and double parallel objects from different types of objects, and you
will then combine parallel objects with mesh generating procedures to
create a free flowing ribbon.
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As the previous example showed, objects need not be planar, for the
Parallel Object operation will automatically triangulate any non planar
surfaces.  When generating parallel objects from open lines, the lines are
not required to be planar either, as the next example will show.  You will first
draw an open line in 3D space, will then derive two more parallel lines, and
you will then use these three lines to create a freely flowing "ribbon."

• Select 20' from the Heights menu and gener-
ate a hexagonal extrusion, as shown.
• Turn on Snap to Segment (window tools).
• With the Vector Line tool active, click on verti-

cal segments of the hexagonal solid to draw the
3D line as shown (click on 1 through 11).
• With the Delete tool click on the hexagonal

solid to delete it since it is no longer needed.

After you turn off  the reference grid, your 3D line
should be roughly as shown.

• Invoke the Parallel Objects dialog. Select
Double Parallel, Center, and in the Wall
Offset: Out and In fields enter 5'.  Under
Status of Objects..., select Keep.
• With the Parallel Object tool active, click on

point 12 to select the 3D line.

Parallel lines are generated on each side of the
original line, roughly as shown.

• Turn off Snap to Segment (if you haven't yet)
and turn on the Perpendicular switch.
• With the Move tool active, click on 13 and 14.

You have moved the original line a bit to introduce
a curvature to the mesh you will be deriving next.

• Invoke the Controlled Mesh Options dia-
log.  Enter # Of Segments 80 for Length and
5 for Depth.   Also select Construct Directly,
and under Status of Objects... select Ghost.
• Use the Pick tool to preselect the three lines

(click on 15, 16, and 17).
• With Create C-Mesh active click on the screen.

Observe the result.  Before the last step, you
could have slightly moved a few of the control
points (topological level at Point) in different
directions to make your ribbon less regular.  This
was done with the last image shown.  You may
wish to Undo and experiment a bit.
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Editing lines

The 3D Line Edit tool ( ) in the 9th row of the tool palette can be used to
break, connect, join, trim, round, and bevel open or closed vector lines.  The
type of editing operation is selected from the Line Editing Options
dialog that is invoked directly from the Line Edit tool.  The Line Edit
operations are useful primarily for correcting data that may have been
imported from other applications.

•From the View menu select Top and draw a 2D rectangle, as shown.
• Invoke the Line Editing dialog and verify that Break is selected.
•With the Line Edit tool active, click on point 1.

Even though you have actually broken the top segment
of the rectangle, nothing different is visible.

• Invoke the Line Editing dialog and turn on Offset:
Left and Right.
•With the Line Edit tool active, click on point 2.

The bottom segment of the rectangle has been broken, and you
can see it because offsets have been applied to the break point.
To verify that the rectangle has been split into two pieces, use
the Move tool to move the right portion, as shown.

• In the Line Editing dialog select Close Line and
Join, and with the Line Edit tool active click on 3.
• In the Line Editing dialog, next to Close Line select
Connect, and with the Line Edit tool active click on 4.
Observe the result.

•Draw two open lines, roughly as shown.
• In the Line Editing dialog select Trim Segments

and with the Line Edit tool active click on 5, then 6.
•Undo, and with Line Edit active click on 5, then 7.

Observe the results.  The lines have been trimmed to their
points of intersection.  Where the mouse is clicked determines
the portion of the segment that is retained.

•Undo.  In the Line Editing dialog select Connect
Segments, and with Line Edit active click on 5, then 6.
•Undo and with Line Edit active click on 5, then 7.

Observe the result.  The ends of the segments where the mouse
is clicked are connected with new segments.

• In the Line Editing dialog select Fit Fillet, in the
Radius field enter 2' and click on 8.
•Undo.  In  the Line Editing dialog select Bevel, and

with Line Edit active click again on 8.

You first rounded and then beveled the corner points.
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Moving, rotating, scaling, and mirroring

To move an object, select the Move operator (  ) from the 11th row of the

tool box, set  the topological level to Object ( ), and click on the object.

The object is rubber banded and follows the motion of the mouse.  Position
it at the desired location and click the mouse again.  This is the post-pick
method.  To use the pre-pick method, select any number of objects using

the Pick operator ( ), then select the Move operator, click in the graphics
window to start the motion, and click again to complete the motion.  You can
also move parts of objects, such as points, segments, outlines, or faces.
You move parts of objects the same way, except that you set the topological

level to the desired object part:  Point ( ), Segment ( ), Outline ( ),

or Face ( ).

When moving an object, you can move the object itself or copies of the
object.  This is determined by the selection of one of the Self/Copy modifiers

on the 10th row of the tool palette.  Self ( ) moves the object itself, Copy

( ) moves a copy, and Repeat Copy ( ) repeats the first motion as
many times as the mouse is clicked.  A double click of the mouse terminates

the copying sequence.  Multi-Copy ( ) automatically makes a certain
number of copies (default number is 6) with a single click of the mouse.  The
number of copies desired is set in the Transformation Multi-Copy or
the Input Options dialog.

To execute a rotation , (1) select the Rotation operator ( ), (2) click on the
object to select it, (3) click to define the center of rotation, (4) click to define
the start of the rotation, and (5) click to define the end of the rotation.  The
object is rubber banded after the 4th click.

To execute a scale  operation,  (1) select the Scale operator (  or ),
(2) click on the object to select it, (3) click to define the base of the scale,
(4) click to define the start of the scaling, and (5) click to define the end of
the scaling.  The object is rubber banded after the 4th click.  Note that there
are two Scale operations.  The first applies an independent scaling factor
in each direction. The second applies the same factor to all three directions.

To execute a mirror or reflection  operation, (1) select the Mirror operator

( ), (2) click on the object to select it, (3) click to define the axis and to start
the reflection,  and (4) click to define the end of the reflection.  The object
is rubber banded after the 3rd click.

The descriptions above apply the post-pick method.  With the pre-pick
method any number of entities are selected first, and then the desired
operator is selected.  The remaining steps are the same.
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Attachments
You can attach parts of an object, a complete object, or
copies of an object, to another object. All the variations

are executed with the Attach ( ) tool.  To experience
the operation, generate two cuboids as shown.

• Invoke the Attach Options dialog and select Ob-
ject Part.
•Set the topological level to Point.
•Select the Attach operator and click on points 1 and 2.

Observe the result.

• Invoke the Attach Options dialog and select En-
tire Object.
•Undo and repeat the operation.

Next, set the Self/Copy mode to Copy and generate the
shown composition by executing a number of point-to-
point attachments.

You can also execute segment-to-segment attachments by setting the
topological level to Segment, and face-to-face attachments by setting the
topological level to Face.  How the segments are selected when executing
a segment-to-segment attachment is significant.  The point of the first
segment which is closest to its pick point is attached to the point of the
second segment closest to its pick point.  If you are not careful, a twisted
result may be produced.  With face-to-face attachments, how the faces are
picked is significant.  A number of justification options are available for the
attachments, and are selected from the Attach Options dialog.

Extending segments

Segments (edges) of objects can be ex-
tended to their intersection with a surface,

using the Extend Segment tool ( ).  To
illustrate the operation, generate two single
wall enclosures,  roughly as shown.

•Set the topological level to Segment and
use the Pick tool to select the four horizontal
segments of the front object.
•Switch the topological level to Face, select

the Extend  tool, and click on the face marked
with the black dot (assuming the single point
face pick option is still selected).
•Repeat the operation by picking the hori-

zontal segments of the other object and the
front face of the front object.
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Placing shapes on lines

The Place ( ) tool is used to position open

or closed shapes (called source shapes ) on
the segments or points of lines (called place-
ment lines ).  This tool is affected by the Self/
Copy modifier.  You can place a shape itself,
a copy of the shape, or multiple copies. To do
a few examples, draw two shapes as shown.

•Select the Place tool and with topological
level at Object and the Self/Copy mode at
Self, click on point 1, then on 2.  The square
has been placed on a segment of the line.

•Set the Self/Copy mode to Copy.
• Invoke the Place On Segment/Point
Options dialog and select Snap.
•With the Place tool selected, click on the

square, and then on points 3, 4, 5, 6, and 7.
Then double click.
A copy of the square was placed  at each point you clicked.
When you clicked on point 7, the program snapped to the
corner point and placed the square at the bisector of its
angle.  It also adjusted its size.  The double click was
needed to exit the copy mode.

Next, you will execute a multi-placement.
Undo six times to return to the original shapes.

•Set the Self/Copy mode to Multi-Copy.
• Invoke the Transformation Multi-
Copy dialog by double clicking on the Multi-
Copy tool.  In the # Of Copies field, enter 10,
and click on OK.
•With the Place tool selected, click on the

square, then on points 8 and  9.  Ten copies
are placed by repeating the distance of the
two points you selected.  The copies placed
on the corner points are properly adjusted.

Next, select the placed squares and use the
Create C-Mesh tool to generate a mesh such
as shown.  (Select At Control Lines and
deselect Smooth for the Mesh Depth.)
Given the special significance that the place-
ment operation has for the meshes, the Gen-
erate C-Mesh option can be selected in
the dialog to generate a mesh as soon as the
placement is completed.
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Insertions
The insertions are controlled by the magenta modifiers on the
first row of the tool box.  Generate a cube as shown.  To insert

a segment on its top face, select the Insert Segment icon ( ),

then select the Draw Vector Line icon and draw a segment as
shown.  Move the newly inserted segment to verify that it has
become part of the object's structure.  The Insert Segment
operation is the only one which does not require a face to be
preselected. All the other insertions have that requirement.

To insert one or more faces, Undo as many times as neces-
sary to return to the original cube.  Then, by setting the
topological level to Face, select its top face (it should turn red),

select the Insert Face modifier ( ), select a 4' height from the

Heights menu, select the Draw Vector Line operator, and
draw a line from one segment of the picked face to the other.
Observe the result.  You can also draw a closed shape, such
as a rectangle, to execute a face insertion.  If the insertion
shape crosses the boundaries of the selected face, the system
will automatically execute a Boolean union.  After the comple-
tion of the operation one of the new faces is returned picked
(red).  You can double click away from the object to reverse the
pick (to cause the other face to be selected).  You can continue
inserting on the picked face to possibly produce a staircase, as
shown.

Again, Undo to return to the original cube.  To insert a hole,
select the top face of the cube, select the Insert Hole operator

( ), select a negative height from the Heights menu, select

the Draw Rectangle icon, and draw a rectangle as shown.
Observe the result.  If the height is large enough, the hole will
be drilled all the way through the object.  A negative height is
needed because the hole is drilled towards the inside of the
object.  The hole insertion is executed as a boolean difference.

The Insert Opening ( )  tool inserts "holes" directly (does not
use a Boolean).  It is faster, but the hole needs to be completely
contained within the boundary of the face.  The opening is
drilled all the way through the object.  Generate an enclosure,
as shown, set the topological level to Face (make certain that
the one point face pick option is still selected), select the Insert
Opening tool, select the Draw Rectangle tool, and draw
rectangles on the walls of your enclosure.  You notice that the
operation is executed even though you did not preselect a
face.  This is made possible by the one point face pick.  The
face is picked from the first point you draw.
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Symbols

Symbols is a method by which entities which must be
repeated in a project may be entered into Libraries and
then placed as instances as many times as is appropriate.

There are four tools for symbols:

Define Symbol

Place Symbol

Edit Symbol Definition

Explode Symbol

If the Symbols palette does not ap-
pear on your screen, open it (select
Symbols from the Palettes menu).
It  should appear with the note "No
Symbol Libraries Loaded" displayed.

1

To define a new symbol you need to have a Symbol Library open (loaded).  You may
already have a Symbol Library which you can load and then add symbols to it or place
symbols from it.  However, now you will start a new Library in which you will save two
symbol definitions.

• Click on the top bar of your symbol palette (next to the word "Library:").
• When the Symbol Definitions dialog appears, click on New....
• When the New Name dialog appears, enter a name and click on OK.

We entered "Mary's_Lib".  You notice that the name you type appears in the
Symbol Libraries window of the dialog.  When you click OK, the dialog
closes and the name you typed appears in the title of your Symbols palette.
Mary's_Lib is empty.  You will next save a symbol definition in it.

• Generate five rectangular extrusions that represent a table, as shown.

We did it by working in 1:1 scale, setting the snapping module to 3", turning grid
snapping on, and using heights 2'-6" for the legs, and 2" for the top piece of the table.
The latter was first created on the XY reference plane and then moved to the top of
the legs.  You will next define a symbol that consists of the objects you just created.

• Preselect the five objects.
• Select the Define Symbol tool and

click on point 1 (origin of XY plane).
• When the Name dialog appears,

enter "Table," and click on OK.

The symbol you just defined appears
in the Symbols palette, as shown.
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Where you click (point 1) when you define a symbol is very significant.  It establishes
the position of the symbol origin .  When placing the symbol, where you click in the
graphics window will define the location of the symbol origin and, therefore, the
position of the symbol.

You will next define one more symbol.  To better see what you are doing,
delete the previous symbol (select the Delete tool and click on it).  Generate
the model of a chair, roughly as shown, then define it as a symbol by
repeating the previous process.  Click on point 2 to establish its origin, and
enter "Chair" for its name.  When the process is complete, the second
symbol appears next to the first in the palette.

On the lower margin of your palette there are a few small icons.  Click on the first (left to
right), then click on the third and observe how your palette changes.  This shows you that
there are three formats in which your symbols can be displayed in the palette, including
one which shows only their names.  You will next place instances of the symbols you just
defined.  Delete the chair symbol to start with a clear project.

• Click on the Table symbol in the
palette to make it active.
• Select the Place Symbol tool.
• Click on point 3 (origin of XY Plane).

A symbol instance is placed as shown.

•Make the Chair symbol active.
•Click on point 4.
•Double click on the Place Symbol tool to invoke

the Symbol Instance Placement Options
dialog.  In its Rotation: Z: field enter 90°.
•Click on point 5.
• Invoke the Placement dialog again and for
Rotation: Z: enter 180°.  Then click on point 6.
•Enter -90° in the Z rotation field of the dialog,

click on 7, and observe the result.

The symbols offer conveniences, save memory, and
allow project-wide manipulations.  Symbols are avail-
able in both the modeling and drafting modules of
form•Z , and there are many options and variations by
which they can be defined, placed, and edited.
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Features not covered in this Mini Manual
As already mentioned, form•Z RenderZone Demo  is a partial version
and does not include some major parts of form•Z , namely the drafting
module and all the export facilities, including saving form•Z  project files.

• The drafting module is intended to support the modeling tasks.  You can
transport images of 3D models into the drafting, where you can further
refine and annotate them with associative dimensions, titles, or notes.
Drawings can also be created directly in drafting, transported into model-
ing and used as base shapes for the creation of 3D models.

• form•Z  models can be saved and exported through DXF, EPS, FACT,
IGES, Illustrator, OBJ, RIB, STL, VRML, 3GDF, and TIFF file formats
under both Mac OS and Windows.  On the Macintosh you can also save
PICT files, as well as QTVR and on Windows 3DS, BMP, and Metafile file
formats.  They can also be imported using most of these formats.

In addition to the features missing from form•Z RenderZone Demo , a
variety of other capabilities that are available in it have not been discussed
in this Mini Manual.  The most important are:

• The Query tool that allows you to request information about objects and
to measure distances.  It can also be used to change the shapes of
controlled objects (curves and  meshes) by changing their  parameters.

• The ability to define and apply Macro Transformations, which are
composite geometric transformations (move, rotate, resize, and  mirror).

• The Cone of Vision function which allows you to manipulate the viewing
parameters of a scene, including 3D clipping, with precision.

• The Underlay item which allows you to import bit-mapped images in
both the modeling and the drafting modes, in order to trace shapes over
them or to use them as backgrounds for modeling scenes.

• The Imager utility that allows you to batch render or print a number of
form•Z  projects in a sequence.

• The ability to save your selection of optional parameters as well as a
variety of other system settings in your own Preference files and to tell the
system to use your parameters next time you run form•Z .

• The ability to copy holes, a rare but very convenient feature.

It should also be noted that even the features that have been discussed
in this Mini Manual have not been covered in full detail.  form•Z RenderZone
Demo  is intended to give you an overview of how the program works, and
to allow you to verify how easy it is to use.  If you have not been able to
make a conclusive evaluation, you may consider ordering the form•Z
Evaluation package, which is essentially a complete but time-limited
version of the program.  If, on the other hand, you have already been able
to appreciate the power and friendliness of form•Z , we would certainly like
to invite you to join the rapidly growing community of form•Z  users.


